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Introduction 

Letter from the President 
 

Dear Valued Customer, 

During the past several years, we have experienced extraordinary growth and change at ATOM 

Instrument, due to our continued commitment to teamwork, technology-focused product strategies and 

to our policy of placing the trust of our customers above all else. We have successfully reached key 

milestones, expanded research and development initiatives, achieved significant technological 

advancements and initiated our position as a premier manufacturer and developer of analytical 

instrumentation. In the face of challenging economic conditions, we are finding new ways to provide 

solutions to an evolving industry landscape to ensure ATOM remains the brightest light on the 

marketplace. 

The upcoming years will be exciting as we continue to broaden our business efforts and move from 

promise to product. We have set increasingly ambitious goals, but possess the passionate vision and 

resources to achieve them. We have the knowledge, experience and expertise to bring specialty products 

to this niche market, and we know the steps we need to take are simply an extension of what we have 

been doing successfully since our inception. Simultaneously, we plan to continue responding to market 

challenges and expand our line of analyzers with products incorporating enhanced features in order to 

engage a wider customer base. Consequently, we have set an aggressive timeline for the development of 

new products to fulfill our commitment to a "total sulfur and nitrogen analysis solution." 

One of our customers has described our success story as "more a marathon than a sprint." We take pride 

in this characterization and embrace it as the philosophy for our operations as a successful business is 

built on sustainable and reliable growth. In recent years, we’ve grown our business substantially, yet 

managed to never waver from our promise to deliver the very best products and service to our valued 

customers. ATOM is building the analyzer tools of tomorrow, hearing the markets’ demands and we are 

ready to meet the challenges. Watch us closely; the next five years will be a defining notch in ATOM’s 

timeline. 

I credit each of our devoted employees for making these past years such a success in turbulent times. I 

would also like to extend my thanks to our customers and our suppliers for their unfailing sense of 

devotion, responsibility, guidance and support, without which our Excimer light would have surely 

extinguished long ago. 

Thank you for the purchase of this ATOM Instrument product and please trust in our commitment to your 

complete satisfaction. Should you have any concerns, please do not hesitate contacting us for support. 

Sincerely, 

Franek Olstowski, President/Founder 
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Mission Statement 
 

ATOM Instrument is founded on fundamental principles and timeless values that perpetually lie 

at the heart of our business and represent the structural foundation on which it is built. 

These principles have helped ATOM Instrument set a higher standard for its products and 

services, making it a recognized leader for innovative solutions. Our mission is to become a 

market leader in the development and manufacturing of analytical instrumentation with 

unsurpassed performance that will fulfill a strategic role in industry to control processes, verify 

product conformance and help solve a variety of problems for the benefit of society. 

 

Creativity 

– To establish and maintain an environment that encourages creativity and promotes innovation 

in order to capitalize on collective talents and intellectual resources, to maintain a technologically 

advanced position and competitive edge within the market. 

 

Quality 

– To provide superior quality products in both form and function while continually striving to 

improve what may already be the best in its class. 

 

Integrity 

– Above all, to conduct all aspects of business operations while adhering to the highest level of 

business ethics and standards. 

 

Dependability 

– To proactively address and reliably respond to our customer’s needs in a timely fashion. 

  

http://atominstrument.com/tech-overview/
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About This Manual 
 
 This manual is a multipart user’s manual that provides information regarding the proper 
installation, operation and service of ATOM Instrument’s TraceS-1000 Sulfur Process Analyzer. The 
manual is divided into the following six sections. 
 

• Section 1  Principle of Operation, Specifications, and Drawings  
 

• Section 2  Software Operation  
 

• Section 3  Basic Maintenance Guide 
 

• Section 4  TraceS-1000 MODBUS Digital Communications 
 

• Section 5  Purge System 
 

• Section 6  Parker Valve System  
 
Warranty, compliance, and safety information concerning the TraceS-1000 Sulfur Process Analyzer is 
provided immediately following this page. 
 
The benefits, features and configurations of the TraceS-1000 are described in Section 1 along with basic 
theory and operations. 
 
Installation and operation of the TraceS-1000 and most optional equipment are illustrated in Sections 2 
and 3 of this manual. Future Information may be supplied in other manuals (i.e., options manuals) or 
addenda to this manual. 
 
Maintenance information includes step-by-step procedures along with a complete set of drawings and 
schematics. 
 
The information contained herein is furnished without warranty of any kind. Users should consider the 
data in this manual only as a supplement to other information gathered by them and must make 
independent determinations of the suitability and completeness of the information. 
 
Some of the terms and labels used in the manual are abbreviated intuitively due to space constraints in 
tables, photos and illustrations. For further explanation, contact ATOM Instrument service.  
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Conditions for Proper Use 

The TraceS-1000 analyzer is designed to be installed, operated and maintained as specified in this 

manual. Failure to operate the analyzer as specified may produce erroneous data and possible 

equipment failure which may void the warranty. Some of the conditions for proper and improper 

use of the TraceS-1000 analyzer are provided as follows: 

• The TraceS-1000 analyzer is designed to continuously analyze gaseous samples from a 

sample handling system and display the amount of sulfur contained in the sample. 

Operation for any use other than specified may damage the analyzer and/or cause 

personal injury to the operator. The results obtained from any other use cannot be 

guaranteed. 

• The standard configuration of the TraceS-1000 analyzer is not intended for extended use 

in corrosive environments. 

• The TraceS-1000 analyzer can be operated in open, outdoor environments but should not 

be exposed to direct sunlight or precipitation. 

• The best accuracy and precision is obtained when the analyzer is located in a temperature 

controlled environment.  

• To ensure safe operation, the purge system should always be engaged during operation 

of the analyzer except after the area has been determined to be non-hazardous and 

repairs or tests must be performed that require the purge system to be bypassed. Refer 

to the manufacturer documentation included in the appendix sections of this manual 

regarding the purge system operation. 

• The electrical power source for the analyzer must be capable of delivering 2400 Watts of 

power. Note that if the sample heat tracing is powered by the analyzer, up to an additional 

600 Watts may be required 

• The sample to the analyzer must be filtered through a 2-micron (min) filter and delivered 

to the analyzer by an approved, leak-free sample handling system to ensure the sample 

being analyzed is representative of the current process status.  

• The sample handling system should eliminate or minimize “dead volumes” and areas in 

the flow path where new sample can be mixed with old sample.  

• Air and other gas supplied to the analyzer must be filtered and meet specified 

requirements. 

• All cautions and warnings in this manual, on tags and in other publications pertaining 

to the installation, operation and maintenance of the analyzer must be read and 

observed. Failure to consider the warning and caution messages can lead to severe 

personal injury, equipment damage and/or void of the warranty. 

• Instrument should be sheltered from direct sun or rain. If the instrument is to be used for 
very low ppm concentrations, it should be located in a climate controlled area. Ambient 
temperature should be between -20°C to +40°C (-4°F to +104°F). 
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Warnings and Cautions  

 
This manual provides caution and warning messages as listed below. Failure to consider these messages 
can lead to severe personal injury, instrument damage and/or void of warranty. 
 
  

WARNING: POWER MUST NOT BE RESTORED UNTIL ENCLOSURE HAS BEEN PURGED 
FOR 10 MINUTES WITH AN INPUT PRESSURE OF 30 PSIG. 

 

WARNING: A SEVERE ELECTRIC SHOCK HAZARD MAY EXIST WHEN POWER IS 
APPLIED WHILE SERVICING INTERNAL COMPONENTS. Ensure that power 
lines are removed from the power source before continuing.  

 

WARNING: A POTENTIONALLY LETHAL ELECTRICAL SHOCK HAZARD EXISTS WHEN 
CONTACT IS MADE WITH THE 120VAC LINE COMPONENTS. Do not 
attempt to repair or test the 120VAC section without using the 
appropriate test meter with insulated probes.  

 

WARNING: AN EXPLOSION DANGER EXISTS WHEN THE DOOR TO A POWERED 
ENCLOSURE IS OPENED WITHOUT FIRST DETERMINING THE SAFETY 
CLASSIFICATION OF THE OVEN AND THE TYPE OF GASES IN THE AREA. 
The area must be known to be non-hazardous before a powered 
enclosure is opened. Follow the procedures for opening and closing a 
powered enclosure.  

 

WARNING: A POOR GROUND CONNECTION MAY PRESENT A SEVERE SHOCK 
HAZARD. 

 

WARNING: HIGH-PRESSURE GASES SHOULD BE HANDLED WITH EXTREME CARE. 
Ensure that all relevant safety precautions are carefully followed and all 
gas lines, regulators, gas purifiers, etc. are specified for the intended use.  

 

WARNING: A PUNCTURE INJURY MAY RESULT IF THE WAGO CONNECTOR 
INSERTION TOOL IS ALLOWED TO SLIP DURING THE INSERTION 
PROCESS. Some force is required to insert the WAGO tool completely into 
the connector. When possible, use a vice to hold the connector during 
insertion.  
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WARNING: IF THE SPECIFIED OPERATING PRESSURE CANNOT BE MAINTAINED, THE 
SOURCE OF THE LEAK MUST BE CORRECTED BEFORE CONTINUING WITH 
INSTALLATION AND OPERATION. Ensure the sample and main gas flow 
is leak free by performing a leak test. 

 

WARNING: EYE INJURY CAN RESULT WHEN HANDLING THE GLASS COMBUSTION 
TUBE. Wear appropriate eye protection during service, removal and 
replacement of the combustion tube.  

 

WARNING: PERMANENT EYE DAMAGE CAN OCCUR DUE TO LOOKING DIRECTLY 
INTO AN ILLUMINATED UV LIGHT SOURCE. Wear appropriate eye 
protection when looking directly into a UV light source.  

 

WARNING: SEVERE BURNS CAN RESULT WHEN WORKING AROUND A HOT 
COMBUSTION TUBE. Allow the combustion tube to cool before 
performing maintenance.  

 

WARNING: SEVERE BURNS CAN RESULT WHEN WORKING AROUND A HOT 
FURNACE. Allow the furnace to cool before performing maintenance.  

 
 

WARNING: AN ELECTRICAL SHOCK HAZARD MAY EXIST AND SEVERE COMPONENT 
DAMAGE MAY OCCUR WHEN USING A LIQUID LEAK DETECTOR. Even 
though the solution in an approved liquid leak detector “Snoop” solution 
is non-conductive, care should be taken not to wet any electrical or 
electronic components.  

 

CAUTION: Most liquid leak detectors contain sulfur compounds that can 
contaminate the gas supply line and instrument flow path components. 
Care should be taken not to wet or contaminate the analytical flow 
system when using a liquid leak detector. 

 

CAUTION: Become familiar with the location and use of all controls, indicators, 
connections and accessories and carefully read all instructions and 
warning labels prior to operating any portion of the system.  

 

CAUTION: The TraceS-1000 should be sheltered from direct sunlight and 
precipitation exposure. 

 

CAUTION: Carefully ensure the system is leak free. Failure to do so may cause 
severe system component damage.  

 

CAUTION: Instrument Air for the sample injection and Parker valves must be set 
to a pressure of 70 psi. Lower activating pressure may result in improper 
actuation while higher pressure may cause damage to these valves.  

 



20170418 ATOM SGA Manual  TraceS-1000 User’s Manual 

TraceS-1000 User’s Manual   Page | 12 

CAUTION: Line Voltage to analyzer must be supplied from an External Power 
Breaker with the specified current and voltage properties. 

 

CAUTION: All seals MUST be poured before energizing the unit. 
 

CAUTION: Follow Installation Drawings and Schematics in this manual to bring the 
unit on line. 

 

CAUTION: Do not attempt to operate the TraceS-1000 until all installation and 
setup procedures outlined in the previous listed sections of this manual 
have been successfully completed. 

 

CAUTION: Serious instrument damage can result if the TraceS-1000 is not fully 
functional and/or if the operator is inexperienced with the computer 
control. 

 

CAUTION: The glass combustion tube is easily broken during removal of the 
transfer tube fittings. Care must be taken not to apply pressure to the 
glass tube when removing the transfer line.  

 

CAUTION: The glass combustion tube inlet and outlet connection points are easily 
broken during removal. Care must be taken not to allow force to be 
applied to the tube when removing these connections from the glass 
combustion tube.  

 

CAUTION: Do not over tighten fittings. Over-tightening can cause restrictions, 
which will affect instrument performance. If ferrules need replacement, 
the fittings should be tightened according to the standard industry 
practice. 

 

CAUTION: The Excimer UV lamp is extremely fragile. Extreme care should be taken 
with these lamps to avoid breakage.  

 

CAUTION: Ensure that all interconnections are properly installed. Improper 
connections may cause damage to system components when power is 
applied.  

 

CAUTION: The Photo Multiplier Tube (PMT) is extremely light sensitive. Any 
exposure to ambient light with PMT power applied will result in 
extreme damage to the PMT. As a result, power to the PMT should 
always be turned off before exposing the PMT window to any ambient 
light. 

 

CAUTION: Ensure all inlet and outlet openings are kept clean and free from 
contaminants. It is recommended that the inlet and outlet openings be 
covered with tape when not connected to lines.  
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CAUTION: Do not exceed recommended pressures. If higher pressures are used, 
severe and irreparable damage may be done to fragile system 
components.  
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Warranty 
 

 
ATOM Instrument TraceS-1000 Standard Warranty 

Atom Instrument warrants that all products supplied will be of merchantable quality and will comply with 
the specification agreed for them. 
 

Atom Instrument guarantees for a period of twelve months from installation of the product or fifteen 
months from delivery to the customer, whichever is the shorter, all Products and spare parts sold 
hereunder. 
 
ATOM Instrument will repair or replace defective and/or nonconforming parts without charge for material 
or labor service during the warranty period. 
 

Products that have been repaired or replaced during the warranty period are themselves warranted only 
for the remaining portion of the original one (1) year. 
 

Repairs, adjustments and service performed after the expiration of the one (1) year warranty period shall 
be charged to the owner/purchaser at the then current prices for parts, labor, and travel related expenses. 
 

Exceptions to this warranty are: 
- Defects, damage, or nonconformity resulting from abuse, misuse, neglect, lack of reasonable care, 

unauthorized modification, or the attachment of improper devices to the products. 
- Installation, operation and maintenance of the products in a manner that does not meet ATOM 

Instrument specifications will void this warranty. 
- All requests for service or repair under this warranty must be received within the warranty period 

by ATOM Instrument or its authorized representative. 
 

The warranties contained in this agreement are in lieu of all other warranties, expressed or implied, 
including the warranties of merchantability and fitness for a particular purpose. 
 

Statements made by any persons, including representatives of ATOM Instrument, which are inconsistent 
or in conflict with the terms of this warranty shall not be binding upon ATOM Instrument unless reduced 
to writing and approved by an officer of the company. 
 

Liability covered under this warranty is limited to the original cost of the ATOM Instrument supplied 
equipment. ATOM Instrument will not be liable for consequential damages including but not limited to 
loss of production, throughput or off specification product due to user or equipment error.  
 

This warranty shall be governed by and construed in accordance with the laws of the State of Texas. 
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Service  
Service Contact Information 
 
Address:         Phone Number: 
1656 Townhurst Dr, Suite G  713-461-0034 

Houston, TX 77043 

Service Rate Information 

ATOM Instrument offers quality service and preventative maintenance work at reasonable rates. 

Our goal is to provide consistent and reliable service with an emphasis on customer satisfaction. 

 
Hourly Field Service Rate: 
Standard Rate (Regular Business Day)   $  187.50 / Hour 
Premium Rate (Weekends)   $  225.00 / Hour 
  
Minimum Charge: 
2-Hour (Customer Location less than 100 mi. from Houston)    $  375.00 
4-Hour (Customer Location greater than 100 mi. from Houston)   $  750.00 
 
Travel Rate: 
Travel Time    $  125.00 / Hour 
Travel Day (8 Hour/ day maximum)   $  1000.00 / Day 
 
Personal Auto Mileage (Rounded IRS Mileage Rate for 2017)    $  0.535 / Mi. 
 
Reasonable Travel Expenses:         Actual Cost  
(Airfare, lodging, surface transportation, meals, etc.) 
 
Misc. Charges:           Actual Cost 
(Includes license fees, customs fees, excess baggage fees, training fees, etc.) 
 
Cancellation Charges: 
Prior to departure for travel expenses incurred       Actual cost 
(i.e. fees for cancellation of airline, hotel, or rental car reservations, plus time spent)  
 
Payment Methods: 

• Purchase Orders from customers with approved credit, Net 30 days. 

• Credit Cards Accepted (MasterCard, VISA, American Express and Discover) 
 

Limited Warranty 
Any replaced parts and service labor performed in replacing associated parts is warranted for a period of 

90 days from the date of service. This warranty excludes travel time and expenses if returning to 

customer site to make repairs is requested. ATOM attempts to maintain stock of essential parts that 

may be necessary for general repairs and preventative maintenance.  
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Recommended Consumable Spare Parts List 
 

Part Number Description Quantity 
60064-00001 SGA Online Combustion Tube, 10.75 L 1 
60038-00001 Combustion Furnace 1 
60097-10005 Type S Thermocouple for Furnace 1 
23058-00001 Valve, 6-Port External Sample Injector, High Temp-Air Actuator 1 
11228-00001 Dryer, .110" ID, 72" L, Fluorocarbon Fittings 1 
60008-10001 Excimer Lamp Envelope 1 
10027-00001 Ferrule, Standard 1/4", Graphite, (2/Pk) 6 

 
 

Recommended Replacement Spare Parts List 
 
 

Part Number  Sample Enclosure Section 
23058-00001 Valve, 6-Port External Sample Injector, High Temp-Air Actuator 

60062-00003 Sample Shut Off Valve to ARV 

11258-00001 Thermocouple, Type K, 6" Long  

10027-00002 Ferrule, Standard 1/8", Vespel 

60037-00001 Sample Enclosure Heater, 120V 400 W, .500" D x 5" L Assembly 

    

  Combustion Furnace Section 
60038-00001 Combustion Furnace 

60097-10005 Type S Thermocouple for Furnace 

   

  Combustion Kit - Includes: 

60064-00001 Online Combustion Tube  

10027-00001 Ferrule, Standard 1/4", Graphite (2/Pk) 

23251-00001 Tubing, PTFE Teflon. 1/8" O.D .x 1/16" I.D. (10ft./Pk) 

23252-00001 Swagelok 2-Piece Ferrule Set (10/Pk) 

    

  Main Enclosure Section 
23248-00001 Nematron 12" Touchscreen PC, Class1, Div.2  

23135-00001 Cyclops Z-Purge System 

60037-00002 Main Enclosure Heater, 120V 400 W, .500" D x 5" L 

11572-00001 Stacklable 3-way Solenoid, Buna O-Rings 

11572-00002 Stacklable 4-way Solenoid, Buna O-Rings 

11478-00001 Connector, DIN, Manifold, 24VDC 

23242-00001 Pressure Switch Assy, Adjustable, 4-125 PSI, 7A, 250V 

23245-00001 Mass Flow Controller, Air 500 sccm 
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 Main Enclosure Section (contd…) 

11506-00001 Temperature Controller, SSR Out, 24V 

11280-00001 Solid-State Relay (SSR), 25A, 240 VAC 

11233-00001 Universal Signal Conditioner, 24V, 4-20 ma Out 

11224-00001 Thermocouple, 30 AWG Type K, PFA 

11262-00001 Thermostat, 1/2" Dis, Auto Reset, 15A Open@ 48.9C, Close@ 32.2C 

11525-00001 Solid-State Relay (SSR), 5VDC, DIN Mount  

11526-00001 Relay, 24V, DIN Mount 

23123-00001 Power Supply, 24V, 4.2A, 100W, DIN Rail 

60078-10001 SP-2000 Signal Processor Board PCA 

60059-10001 External Interface Board PCA 

60079-00004 DC/DC Converter, Quad 24/5V,+15V,-15V,12V 

60003-10001 Detector with PMT 

60008-10001 Excimer Lamp Envelope 

60001-10001 Excimer Lamp Assy 

11228-00001 Dryer, .110" ID, 72" L, Fluorocarbon Fittings 
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Section 1 – Principle of Operation, Specifications, and 

Drawings 
 

Section 1.1 Principle of Operation 
 

The ATOM TraceS-1000 has the highest dynamic measurement range of any commercially 
available analyzer without the need for additional sample valves, calibration gases or system 
hardware. In addition, the ATOM TraceS-1000 does not require installation in a controlled 
environment shelter. 
 
The ATOM TraceS-1000 is an online process analyzer utilizing patented Excimer UV Fluorescence 
(EUVF) technology to measure Total Sulfur in a variety of applications such as monitoring of total 
sulfur in process gas streams. 
 
The UV Fluorescence method (UVF) is one of the most simple and practical low-level sulfur 
analytical techniques that has been widely used and proven over many years of industrial 
utilization. The UV Fluorescence method involves injection of a sample into a high-temperature 
oxidation or combustion furnace, which converts all hydrocarbons into water (H2O) and carbon 
dioxide (CO2) byproducts. Total Sulfur content contained in any molecular-bound hydrocarbon 
species is similarly oxidized at temperatures in excess of 1000°C into sulfur dioxide (SO2) by the 
reaction: 
 

R-SH + O2 → SO2 + CO2 + H2O 
 
The furnace effluent containing these combustion byproducts is directed into a detection 
chamber where it is excited by high-energy, short-wavelength emission from a UV excitation 
source. The UV photons from the excitation source or lamp, transfers energy into the SO2 
molecule and raises its energy level to create an excited singlet state. These excited molecules 
rapidly decay back to their lower energy ground state releasing the absorbed energy as a 
secondary emission known as fluorescence. 
 

SO2 + hυ → SO2* → SO2 + hυ’ 
 
This low-level fluorescence emission is optically filtered to remove undesired wavelengths of the 
UV source and background scatter within the detector chamber. Detection of the filtered 
fluorescence emission is usually accomplished with a Photomultiplier Tube (PMT), Channel-Plate 
Multiplier (CPM) or other high gain, light-sensitive detector.  
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Section 1.2 Specifications 
Analytical Performance       

Measurement Method   Total Sulfur by Excimer UV Fluorescence (EUVF) 

Measurement Range   0 – 10,000 ppm (higher range available on request) 

Repeatability   50 ppb SD or ±2% of measured value, whichever is greater  

    30 ppb SD with 5-min. averaging   
Linearity     ±2% of full scale 

Response Time    100 sec. to 99% of new value   

Calibration    Automatic or manual   

         
Analog/Discrete Data 
Communications      

Analog Outputs   Two 4-20 mA DC (optional)   

Alarm Outputs    

 
One global dry contact triggered by one or more of the 
following: 

    

Power Failure, Loss of Purge, Low Oxidizer Pressure, User-
configured Digital Inputs (DI4 – DI7) 

     
Digital Data 
Communications  RS-232, RS-485/422 MODBUS (TCP/IP optional) 

        
 
Local MMI    12" Touchscreen Computer with Embedded Windows 7  

    

allows complete operation and control of all analyzer 
functions 

 
Remote Interface   Complete control of ATOM SGA, including monitoring of  

    analysis parameters and digital data values 

         

Utility Requirements       

Ambient Temperature   20°C to 40°C (68°F to +104°F)  
Power     120 VAC, 25 A, 50/60 Hz at 3000 watts  
Instrument Air    70 psig (4.8 bar), 7 SCFM, Oil Free, -40°C (-40°F) dew point 

Zero Grade Air     70 psig (4.8 bar), 200 SCCM   

         

Physical Parameters       

Dimensions   

965.2 mm (38.0 in) high x 660.4mm (26.0 in) wide x 304.8 mm 
(12.0 in) deep 

        

Mounting   Wall or Unistrut Stand   
 
©2018 ATOM Instrument, LLC. All rights reserved. Specifications, terms and pricing are subject to 
change. 
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Section 1.3 TraceS-1000 Drawings 
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Section 1.3.1 Installation Drawings 
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Section 1.3.2 Process Flow 
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Section 1.3.3 Total System Wiring 
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 Section 1.3.4 

Main Enclosure 
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Section 1.3.5 Furnace Enclosure 
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Section 1.3.6 Sample Enclosure 
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Section 2 – Software Operation 
 
This section of the manual is intended to provide a complete overview of the TraceS-1000 
software providing the user a fundamental understanding of analyzer operation.  
 
There are 3 programs incorporated into TraceS-1000 software that have distinct functions, but 
work together to provide complete control and user interface of the TraceS-1000 instrument. 
The main TraceS-1000 software program operates in the background and controls all aspects of 
analyzer operation, which includes protocols for communicating with the detector module. The 
detector module firmware is a distinctly separate, machine-language program embedded in the 
onboard microprocessor. The third program is a colorful, high-contrast Graphical User interface 
or GUI that provides a user-friendly interface comprised of an organized set of intuitive menu 
screens that are configured for ease of use. 
 

Start Up  
 
Upon powering up the TraceS-1000, the touchscreen will begin to turn on and Windows 7 will 
boot. If an administrator password has been set up for Windows 7, the password can be entered 
using an external keyboard plugged into a USB port to access the software. If no keyboard is 
connected, the touchscreen keyboard can be displayed by pressing the “Ease of access center” 
button at the bottom left of the screen and then selecting the “Type without the keyboard (On-
Screen Keyboard)” option. 
 
If no Windows administrator password has been implemented, the main GUI menu (Figure 2.1) 
will open automatically after the TraceS-1000 and touchscreen computer are powered on. All 
sub-menus may then be accessed from this bar found at the top of the desktop screen.  
 

 
Figure 2.1 – Main Menu 

 
In order to access any of the sub-menus of the GUI, the user must first log into the system. Refer 
to section 2.1.1 for Login information  
 

Section 2.1 File Menu 
 

 
Figure 2.2 – File Dropdown Menu 
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Section 2.1.1 Login 
 

The Login feature allows users to interface with the software on two separate levels. Users 

without administrative privileges are limited to menu access for viewing purposes only. Those 

users with administrative privileges have complete access to all menu settings, which can be 

modified as necessary for customizing or optimizing instrument operation (selectable in User 

Setup, Figure 2.6). The Login feature is intended to prevent unauthorized changes to instrument 

operation, allowing it to retain current settings unless an authorized user logs in with valid 

credentials (Figure 2.3).  

 

To log in to the analyzer, click File > Login. Press the ID line. 

  

 
Figure 2.3 – Login Screen 

 

A touchscreen keyboard should automatically pop-up on the screen (Figure 2.4).  

 

 
Figure 2.4 – Touchscreen Keyboard 

 

Using the touchscreen keyboard, enter the username ID. Then press the Password line and enter 

the user assigned password. After proper user credentials have been entered, press the OK 

button to complete the Login process.  

 

NOTE: At any attempt to access a screen that requires administrative privileges, the Login 

screen will automatically pop-up and prompt the user for the required credentials.  

 

NOTE: The dropdown menu will read Logout if a valid login has already been entered 

(Figure 2.5). 
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Figure 2.5 – User Already Logged In 

 

There is an auto-logoff feature in place to automatically logout any user after 15 minutes of 

inactivity. After this time, any screen that requires administrative privileges to change or modify 

settings will automatically cause the Login Screen to reappear and prompt the user to re-enter 

the required credentials. 

 

Section 2.1.2 User Setup 
 

 
Figure 2.6 – User Settings Screen 

 

The User Setup screen is accessed from File > User Setup. Four levels of users are defined in the 

ATOM GUI: Admin, Tech, View and Other (no box selected). Below is a description of each user’s 

rights: 
 

 Admin Tech View 
View any GUI screen X X X 
Modify analyzer parameters X X  
Modify user privileges X   

 

When logged in as an Admin, pressing the X box will delete the user profile (Admin cannot be deleted). 

To change a user level, clicking the corresponding desired box will change user privileges. To add a user, 

click the ID field and enter the user name, a password and user level are then selected to finish user 

registration. Default password is “0”.  
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Section 2.1.3 Exit  
 

By clicking File > Exit, the GUI program will close; however the TraceS-1000 main program will 

continue to run if there are no operational restrictions, such as loss of purge or other system 

critical alarm function.  

 

Section 2.2 Settings  
 

 
Figure 2.7 – Settings Dropdown Menu 

 

Section 2.2.1 Home 

 

The Home Screen is the top screen in the Settings menu and is considered to be the primary user 

interface for an overview of routine analyzer operation. (Figure 2.8). The Home menu functions 

are arranged in groups and are discussed separately.  
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Figure 2.8 – Home Screen Detailed 

 

Stream Selection and information 

 

In this part of the home screen, the user may select which streams are run by checking 

the box adjacent to the desired stream. When a stream is under analysis, a green radio 

button is activated next to the stream being analyzed. 

 

The user may choose the number of cycles ran during each stream analysis. Clicking on 

the Cycles number will open a text box which allows the user to select up to 9 cycles per 

analyses. 

 

The Cycles Run counter indicates analysis progression. When all cycles requested by the 

user are completed, the analyzer switches to the other stream (if both streams are 

checked). 
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Run Cycle Status 

 

The Run Cycle Status section of the Home Screen displays information regarding various 

aspects of the Run Cycle in process. 

 

Start/Stop Button: 

The analyzer software is designed so that the Analysis Cycle runs all the time, and will 

automatically restart upon restoring power after a power shutdown. Exceptions to the 

continuous run feature are: 

 

1. There is an Alarm condition. 

2. The Run Cycle is manually stopped. 

3. The analyzer is Purging due to an Auto Calibration Check, or return to 

Process. 

4. The analyzer is Holding as part of the Run Cycle Mode. 

 

When the button is labeled STOP with a green LED, a cycle is either running, or is 

scheduled to run. Pressing this button will cause the cycle to stop after the current cycle 

has completed. When stopped, this button will be labeled START with the LED off. 

Pressing this button again will change the label to STOP and initiate a new cycle run. 

 

Event Indicator 

Beneath the START/STOP button is an indicator that displays various events related to the 

Run cycle. Some of the events the Event Indicator will display are, Not Ready, Holding and 

Purging. Whenever a cycle is currently running, it will display timed events as they occur 

such as Injecting, Baseline Evaluation and Peak Integration periods.  

 

Cycle Time 

The Cycle Time in the Run Cycle Status displays the current cycle time in elapsed seconds. 

The standard cycle time for the TraceS-1000 is 100 seconds. Once the current cycle is 

complete, it will start a new cycle at time 0. 

 

Cycle Number 

The Cycle Number displays the total number of completed cycles the analyzer has run 

since the analyzer was started. This number will increase until the cycle is stopped and 

will continue to increase once the cycle has restarted. This number will only be reset on 

power down of the detector or analyzer. 
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System Control 

 

The System Control section of the Home Screen shows the status of the PMT and UV Lamp 

voltages, the presence of any Zero baseline offset value, and status of the TraceS-1000 

alarm system.  

 

PMT HV  

This button controls high voltage to the Photo-Multiplier Tube and indicates whether it is 

ON or OFF. The LED will be GREEN if powered ON and is turned OFF by pressing the button 

to toggle.  

 

UV Lamp 

This button controls power to the Excimer Lamp Module and operates in similar to the 

PMT HV button in its ON/OFF functionality.  

 

Zero BL 

This button allows any baseline level to be zeroed for graphic display purposes, or the 

analyzer analog output when the detector signal is selected. This function must be 

enabled in the Detector Settings Screen which will be discussed later in the Software 

Operation section. Zeroing the baseline level will not affect acquired results or 

calculations of total sulfur composition.  

 

Analyzer Alarm Status 

This line will display Normal with green LED when the analyzer is running properly. This 

line will display Warning with yellow LED when something on the TraceS-1000 requires 

attention but is not critical enough to affect normal analyzer function. Should a system 

critical situation arise, this line will display Alarm with red LED indicating an alarm 

condition exists. If this occurs, the TraceS-1000 is designed to stop the current Run Cycle, 

which may also include combustion furnace shutdown, and activate the Global Alarm. 

(Figure 2.9) 

 

  

  

 

 

 

 

 

 

Figure 2.9 – Normal, Alarm, and Warning Status 
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NOTE: The status of this indicator will also be prominently flashed on the menu 

bar should the TraceS-1000 go into either WARNING or ALARM mode. 

 

Variable Display Section 

 

The Variable Display section allows monitoring of up to three user selected variables with 

associated bar graphs whose ranges can be chosen as necessary to provide a customizable 

display, depending on customer preference. Although any combination of variables can 

be chosen, the graphs are set by default to Detector mV, Stream 1 ppm and Stream 2 

ppm. These displays will hold their current value until a new value is calculated, replacing 

the old reading with the most recent one. Pressing any of the three buttons above the 

graphs will open a list of available display variables, which can be selected by highlighting 

the intended variable and pressing the OK button. (Figure 2.10) 

 

 
Figure 2.10 – Variable Display Selection Menu for View 2 

 

Pressing the RANGE button allows the bar graph range to be selected in a likewise fashion. 

The desired range is chosen by selecting the adjacent radio button (Figure 2.11). 
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Alternatively, it is possible to choose a user defined range in the bottom last line of the 

table. 

 

 
Figure 2.11 – Variable Range Selection Menu 

 

Section 2.2.2 Calibrate Settings 
 

The Calibrate settings screen (Figure 2.12) is where all information regarding instrument 
calibration and associated calibration results are displayed.  
 
To access this screen press Settings > Calibrate Settings 
 

 
Figure 2.12 – Calibrate Settings Screen  
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Check Cycle Status 
 

The Check Cycle Status allows the user to monitor and review acquired Check Cycle 
results, as well as the progress of the Check Cycles in progress.  
 

  View Results  
Pressing the View Results button opens a separate menu and displays up to ten runs in a 
Cycle Set, allowing them to be viewed as they occur during Manual or Auto Check Runs. 
The results displayed are computed with the Response Factor (RF) currently in use (Figure 
2.13). 
 
If a calibration check is in progress, results are updated in real-time as they occur. If the 
last calibration check is finished, these results will display all acquired values within the 
last calibration check set. Although “check calibration” results can be viewed at any time, 
they will be wiped clean and replaced with new data whenever the next Manual or Auto 
Check calibration is performed. Both Zero and Span sections display Area and 
Concentration values associated with the calibration check, as computed with the 
previously accepted Response Factor (RF). 
 

 
Figure 2.13 – Check Calibration Results Screen 

 
  Cycles Run 

The Cycles Run Line indicates the number of completed runs from the number of cycles 
selected for the calibration check set. 

 
Cycle Controls 
 

The Cycle Control section of the menu allows the user to set the number of calibration 
cycles desired for each Check Calibration Set, as well as the amount of purge time 
between cycles.  
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Cycles/Set  
The Cycles/Set button allows any number of cycles to be selected between 1 and 10 for 
the desired set of runs. This number of cycles will be applied to each Zero, Span or Validate 
samples when selected. By pressing the Cycles/Set button a window will pop-up as well 
as the touchscreen keyboard in order to enter the desired number of cycles to be run. 
Press OK to set this value. (Figure 2.14) 
 

 
Figure 2.14 – Enter Value Screen 

 
   NOTE: The Enter Value Screen will pop-up throughout the software when required.  
 

Purge (Sec) 
The Purge (Sec) button allows the user to select the purge time between sets. This is 
intended to allow sample concentrations to reach equilibrium prior to starting a 
calibration check set. The optimal time setting will depend on sample flowrates and dead 
volume between the selection valves and analyzer. 
 
The purge time will be applied during transition times between running process and a 
calibration check sample, between each set of calibration checks, and before returning to 
running the process sample. 
 
If the analyzer is in purge mode, the Home Screen will display Purging on the event line 
and the clock counter will decrement from the chosen setting to “0” seconds.  
 
** Note:  A loss of purge will cause the analyzer to go into “Alarm”, and the 

analysis is immediately stopped. If this Alarm event occurs right after 
sample injection, then this sample will still be present in the system even 
after the alarm condition clears. Once the Alarm is cleared, the analyses 
resume after purging for the set duration (Purge (Sec) set as shown 
above under Calibration Settings).  

 
If the purge is set for a shorter duration, it may not be enough to sweep 
the previously injected sample out of the system, before the next sample 
injection. This increases the probability of system coking. To avoid this, it 
is recommended that the Purge Time be set to a minimum of 60 
seconds. 
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Calibrate Values 
 

This section displays all values used or associated with instrument calibration.  
 
Check Zero and Span  
The Check Zero and Check Span buttons display acquired values from the most recent 
calibration check. After the calibration checks are finished average calculated areas of 
Zero and Span will be displayed in these buttons. These values will be used for analyzer 
recalibration if considered acceptable by the user. Calculated values can be overridden 
with any User specified value.  

 
Saved Zero and Span 
Values on these lines display previously accepted areas utilized for calibration purposes.  
 
Zero and Span Concentrations 
The Zero Conc and Span Conc buttons allow the user to enter known concentration of 
samples, generally utilizing the certified values provided by the calibration gas supplier. 
The Cal Units button allows the user to select the concentration for both values to be 
entered in either percent or PPM. 
 
RF=Count/ppm 
The RF=Count/ppm button displays the most current response factor. The response factor 
(RF) is primary number used to calibrate the instrument. The number represented as 
Counts/PPM is a value proportional to the difference in area divided by difference in 
concentration.  
 
If modification to the calculated RF is preferred, or instrument performance utilizing a 
randomly selected RF without calibration is desired, the user merely presses the 
RF=Count/ppm button and enters the chosen RF.  

 
Manual Check 
 

The Manual Check section allows the user to manually run a ZERO, SPAN, or VALIDATE set 
of run cycles. The ZERO and SPAN functions will use the sample bottles that are connected 
to their respective inputs to calibrate the TraceS-1000. The VALIDATE function will run 
any concentration of a known sample to ensure the TraceS-1000 accurately measures the 
intended concentration. 
 

Auto Check 
 

The Auto Check section of the Calibration Settings allows the user to set up routine 
calibration checks.  
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The Enable button enables or disables auto check feature, as indicated by the embedded 
LED. Any or all of the three possible gas standards can be included in the Auto Check run 
by selecting the adjacent box to include a checkmark. The user can also specify the desired 
auto check schedule utilizing the Freq (Days) and Time (24Hr) buttons. The time of day is 
always entered in 24-hour format. 
 

Demo Mode 
 

The Demo Mode button allows the user to substitute previously recorded data in place 
of real-time detector data without having to run actual samples. The Demo Mode feature 
is enabled by pressing the button as indicated by the lit LED.  
 
If the SGA is analyzing process sample when Demo Mode is enabled, normal detector 
signals will be substituted with pre-recorded data from a 50% concentration sample at 
the end of the current Run Cycle.  
 
If the SGA is analyzing calibration sample, whether in Manual or Automatic mode, the 
50% concentration sample data will be substituted whenever Span is selected. 
 
If Zero gas is selected, a different set of pre-recorded data representing near-zero sample 
concentration will be utilized. If Validate is selected, pre-recorded data representing 25% 
total sulfur sample concentration will be utilized. 
 
It is important to note that there are a total of 7 continuous runs recorded for each of the 
above pre-recorded concentrations. If more than 7 cycles are selected to run in a cycle 
set, the pre-recorded analysis data will merely repeat every 7 cycles, and include any 
portion thereof necessary to complete the intended set. The detector will return to 
processing normal real-time signals after DEMO mode is turned OFF.  

 

Last Validation 
 

This section of the menu shows the last validation the TraceS-1000 performed with the 
date and time. 

 
Calculate RF 
 

 After Manual or Auto Check is complete, the analyzer will display the new data for zero 
and span values in the “Check” section. Pressing the “Calculate RF” will automatically 
calculate the response factor based on the difference between Zero and Span areas from 
the latest Check Calibration run. 

 
Save Calibration 
 



20170418 ATOM SGA Manual  TraceS-1000 User’s Manual 

TraceS-1000 User’s Manual   Page | 42 

 Whenever any calibration check information has changed, such as completion of a 
calibration set, manual change to calibration check values, or a response factor that has 
either been calculated or manually entered, the Save Calibration LED will indicate new 
calibration values that remain to be entered. All changes will not come into effect until 
the Save Calibration button is pressed. 

 

Section 2.2.3 Detector Settings 
 

The Detector Settings screen contains information about the detector and settings that can be 

altered (Figure 2.15).  

 

To access this menu press Settings > Detector Settings 

 

  
Figure 2.15 – Detector Settings Screen 

 

Detector Settings 

 

This part of the menu allows the user to change the PMT HV (Photo-Multiplier Tube High 

Voltage) and change the filtering constant of the data collected. 

 

The PMT HV button lets the user change the high-voltage applied to the PMT to adjust 

detector sensitivity and associated peak height to the desired level. The PMT HV default 

value is 800V, but is typically modified as necessary at the factory. The maximum voltage 

setting is 1099 volts.  

 

The Filter (sec) button controls the detector filtering constant, or a rolling “box-car” 

average of individual 1-sec detector count readings. The optimal setting for the TraceS-
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1000 is 8 seconds for best results, which is a time constant that allows maximum 

smoothing of detector data without significantly affecting overall peak height.  

 

Baseline Correction 

 

This section allows the detector baseline to be modified as desired for graphing or output 

purposes. 

 

The Zero Enable button allows the baseline to be zeroed either manually, or 

automatically. To turn this function ON press the Zero Enable button and the indicator 

will turn GREEN. To turn it OFF press the button again and the indicator will be BLACK.  

  

Manual zeroing of the baseline is accomplished by pressing the Zero BL button in the 

System Control Section of the Home Screen. Automatic zeroing of the baseline is defined 

in the Timed Events Settings and will occur during the programmed time. Even if the Zero 

Enable button is enabled, a program time of “0” will prevent automatic zeroing of the 

baseline. 

 

Applied μV 

The Applied μV line displays the voltage applied to the normal detector baseline to shift 

it to zero. This value is cumulative each time the baseline is zeroed either manually or 

automatically. When the Zero Enable button is turned off, any cumulative offset value is 

dropped and the baseline will return to its normal state. 

 

Offset μV 

Whether the Zero Enable button is enabled or not, the Offset μV button allows the user 

to readjust the baseline to any desired value. 

 

Run Cycle Settings 

 

The Run Cycle Settings allow the mode of cycle operation to be selected. The three modes 

of operation are Repeat, Hold and Stop. 

 

If the selected mode is Stop, a running cycle will stop at the end of programmed cycle 

time. If the selected mode is Repeat, a new cycle will immediately restart after the current 

cycle ends. If the selected mode is Hold, a new cycle will start after the Hold time has 

elapsed. Whether the analyzer is in Repeat or Hold modes, cycles will run continuously 

until a) the cycle is manually stopped; b) an alarm condition arises; or c) power to the 

analyzer is turned off. 
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Section 2.2.4 Digital I/O Label 
 

The Digital I/O Label screen contains assigned names for all digital inputs and outputs (Figure 

2.16).  

 

To access this menu press Settings > Digital I/O Labels 

 

 
Figure 2.16 – Digital I/O Labels Screen 

 

The Digital I/O labels above have been assigned as default names by the factory. To change any 

of these, the text is selected by pressing the desired line, which will pull up the touchscreen 

keyboard. The user then enters any alternate name or text desired, and presses the OK button. 
 

Section 2.2.5 Digital I/O Status. 
 

The Digital I/O Status screen is consolidated screen to check the status of all the digital inputs 

and outputs (Figure 2.17).  

 

To access this menu press Settings > Digital I/O Status 
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Figure 2.17 – Digital I/O Status Screen 

 

DI (Digital Input) Status  

 

This section displays the digital inputs in their normal operating state. Digital inputs 1-3 

reflect the presence of system critical parameters that are described in the System Setting 

menu. Digital inputs 4-7 are unassigned with current SGA software. Digital input 8 has 

been configured to operate as a digital output and is essentially considered “DI-9”. 

 

DO (Digital Output) Status. 

 

This section displays the status of all digital outputs as indicated by the associated LED. 

The digital outputs are configured as 24V DC signals that operate a variety of valves and 

relays from the External Interface board. When the analyzer is running, these outputs 

automatically turn on and off as required by timed events and calibration settings. For 

troubleshooting purpose these outputs can be manually turned on and off, only after the 

run cycle is stopped. 
 

Section 2.2.6 Output Settings  
 

The Output Settings screen allows the user to select the desired variable and scaling for both 

Analog Output channels available with TraceS-1000 (Figure 2.18).  

 

To access this menu press Settings > Output Settings 
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Figure 2.18 – Output Settings Screen 

 

The Output Settings menu is divided into two identical sections for Analog Output 1 and Analog 

Output 2. Pressing the Variable button will open a list of available parameters from which the 

user can choose the desired variable by selecting the adjacent radio button (Figure 2.19). The 

Low Value and High Value buttons permit the input range to be defined, regardless of the 

variable selected. Pressing these buttons will open the touchscreen keyboard and enable 

modification as necessary. 

 

 
Figure 2.19 – Output Variables Dropdown Menu 

 

The Out FS mV button allows the output range of the associated DAC to be set. The 18-bit DAC’s 

have a specified output of 0-4000mV. Although lowering this value will allow 100% of range High 

Value to be achieved at a lower output voltage, the total number of bits representing this value 

would be correspondingly reduced. In order to capitalize on all available 18-bits of resolution, 
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and to satisfy the Signal Conditioner input requirement of 0-1 VDC, the circuitry incorporates a 

4:1 voltage divider built into the SP-2000 signal processing detector board. Therefore, even 

though the Out FS mV is set to 4000mV, the resulting DAC analog voltage output is reduced to 

1000mV at this setting.  

 

The Out % FS Line will always indicate the current variable value relative to the variable range in 

percent full scale.  

 

Section 2.2.7 Purge Override 
  
The TraceS-1000 has been certified for use in Class 1, Division 2 hazardous locations and purge 
pressure is necessary for maintaining certification requirements (See Section 6). The analyzer 
purge is intended to maintain positive pressure on the analyzer enclosures to prevent ingress of 
potentially hazardous atmospheres. Purge monitoring of the TraceS-1000 is accomplished 
utilizing the Cyclops Z-purge device (See Section 5). 
 
The purge override feature (Figure 2.19) is incorporated into the SGA software to permit analyzer 
operation without enclosure purge pressure. This enables the enclosure doors to be open for 
inspection or maintenance of the analyzer when the area is known to be non-hazardous. 
 
Access this mode by pressing Settings > Purge Override 
 

 
Figure 2.19 – Purge Override Menu 

 
The default time for Purge Override is 10 minutes. Pressing the Start button initiates the Purge 
Override function for the designated time. The time at the bottom of the menu reflects time 
remaining before the Purge Override function is disabled. 
 
Should a different Purge Override time be desired, pressing the Minutes button will open an 
Enter Value window that allows the user change the Purge Override time up to 1,092 minutes, 
or just over 18 hours. Should more time than the originally entered time be necessary, the user 
may enter a new value at any time. Pressing the Off button will revert back to normal operation, 
but Purge Override should only be stopped after the enclosure doors have been closed and purge 
is reestablished to avoid shutdown of furnace and Run Cycles.  
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Section 2.2.8 System Settings 
 

The System Settings menu allows the user to configure WARNINGS and ALARMS for the TraceS-
1000. To access this menu press Settings > System Settings 
 
System parameters are arranged in two groups. The top four parameters are digital inputs that 
monitor operational requirements, the first three of which are assigned and last being 
unassigned. The assigned parameters (Loss of Purge, O2 Pressure Low and Furnace Temperature 
Low) are considered to be system critical conditions and are already configured for Alarm by 
default. The DI4 parameter is unassigned and can be utilized as a customer configurable digital 
input (Figure 2.20). 
 

 
Figure 2.20 – System Settings Screen 

 
The designated trip points for the system critical parameters are as follows: 
  

Parameter Trip Condition 

Loss of Purge Enclosure Pressure Falls below 0.2” H2O pressure 

O2 Pressure Low Zero Air Used for Combustion less than 20 PSIG 

Furnace Temp Low Combustion Furnace Temperature less than 1025°C  

 
The remaining parameters are not system critical, but are intended to monitor results 
calculations for Zero Value, Span Value, Stream 1 and Stream 2. These parameters allow the user 
to select both Low Alarm and High Alarm limit settings, by entering the desired value in ppm after 
pressing the associated button. The most recent calculated values are also displayed between 
the High/Low limit settings for reference. Any or all of the System parameters shown can be 
programmed to generate a WARNING or ALARM if triggered. 
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NOTE: The values used for alarm triggers in the Zero, Span and Stream sections are averaged 
values. To modify the number of runs in the Zero and Span average, please refer to section 2.2.2, 
for the Stream average, please refer to section 2.3.3. 
 
Alarm 
 

If an ALARM status is enabled for any parameter, and that parameter falls out of its 
designated range, the TraceS-1000 will trigger an alarm that will be indicated by a red LED 
in the State column (Figure 2.21). 
 

 
Figure 2.21 – Loss of Purge Alarm 

 
Any ALARM state will be reflected by the Analyzer Alarm Status line at the bottom of the 
System Control section of the Home Screen (Figure 2.10). The message ALARM!, will also 
be prominently flashed in the Main Menu bar in large red text (Figure 2.22).  
 

 
Figure 2.22 – Main Menu Alarm 

 
As soon as an ALARM state is triggered, the analyzer is designed to immediately shutdown 
power to the combustion furnace and stop any currently running cycle. In addition, the 
GLOBAL ALARM relay will be activated. Run Cycles will automatically resume as soon as 
all alarm conditions are cleared, and after any programmed Purge time has elapsed. This 
also means that all alarm conditions must be clear before any Run Cycles can be started. 
  
NOTE: The default ALARM assignment for system critical parameters should never be 
changed, unless necessary in special situations, such as troubleshooting or demonstration 
purposes. Disabling these alarms or changing the status to WARNING can result in 
damage to the system and void the warranty. 

 
Warning 
 

If a WARNING status is enabled for any parameter and that parameter falls out of its 
designated range, the TraceS-1000 will trigger a warning that will be indicated by a yellow 
LED in the State column. Similar to ALARM status, the Warning will be also be reflected 
by the Analyzer Alarm Status in the System Control section of the Home Screen, as well 
as be prominently flashed in the Main Menu bar (Figure 2.23).  
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Figure 2.23 – Main Menu Warning 
 
Any parameter enabled to generate a WARNING status, should it fall outside the 
designated range, is not considered to be a critical parameter for system operation. It is 
primarily intended to alert the user to a condition that may require intervention. It should 
be noted that Loss of Purge is hardwired to shut down power to the furnace regardless of 
whether that parameter is checked for ALARM, WARNING, or neither. However, Run 
Cycles will only be stopped when an ALARM condition exists. 

 
NOTE: If disabling the alarm or warning is desired before the condition is restored, the user may 
simply uncheck the box until the parameter is to be monitored again. 
 
NOTE: If both ALARM and WARN are checked for any specific parameter, the priority will always 
be given to the ALARM whenever that parameter is out of range. 
 

Section 2.2.9 Timed Event Settings  
 

The Timed Event Settings menu allows the user to configure all timing functions associated with 
the Run Cycle (Figure 2.24). To access this menu press Settings > Timed Events.  
 

 
Figure 2.24 – Timed Event Settings Screen 

 

The Timed Events Settings menu contains 6 separate Cycle Timed Events. These events are 

defined by 10 programmed timing entries that stipulate Run Cycle control and operation. Timed 

Events within this menu include:  

 

Event Name Description 

Inj Start Sample Valve is turned ON to Inject Sample in Loop 
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Inj Stop Sample Valve is turned OFF to Reload Sample Loop 

SSO/ARV Start Sample Shut Off turned ON relieving Excess Pressure to Atmospheric Reference Vent 

SSO/ARV Stop Sample Shut Off turned OFF returning Normal Sample Flow through Inject Valve 

Auto Zero Sets Time when Auto Zero of Baseline is Performed (Setting of 0 = Off) 

BL Start Initiation of Baseline Evaluation Period; Values Averaged Establishing BL Value. 

BL Stop Completion of Baseline Evaluation; BL Average used to Correct Area Count Readings 

Peak Start Initiation of Peak Integration Period; Begin Summation of BL Corrected Readings 

Peak Stop Completion of Peak Integration Period; Sum All Data to Generate Peak Area Value 

Cycle Secs Sets Cycle duration and Defines completion of the Cycle Time. 

 

To change the timing entry for any of these events, press the associated button that will open an 

Enter Value screen. The user enters the desired time in seconds and presses the OK button. 

Generally speaking, all settings provided in the Timed Events menu by the factory have already 

been optimized for best analyzer performance. Although the user is at liberty to make changes 

to these settings, analyzer performance cannot be guaranteed whenever factory settings have 

been modified from their original values.  

 

NOTE: A value of zero (0) in the Timed Events Settings will turn off the event  
 

Section 2.3 View 
 

The View menu group contains submenus that provide information regarding instrument 
performance, but does not contain any settings related to instrument operation. (Figure 2.25) 
 

 
Figure 2.25 – View Dropdown Menu 

 

Section 2.3.1 Historical Calibration Results  
 
The Historical Calibration Results menu allows the user to review previous calibration results that 
were archived by pressing the Calibrate and Save button in the Calibration Settings menu. (Figure 
2.26). To access this menu press View > Historical Calibration Results. 
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Figure 2.26 – Historical Calibration Results Screen 

The menu is similar to the Check Calibration Results menu, but with supplemental information. 

The top line shows the date and time the displayed calibration information was saved. Pressing 

the down arrow located on the far right of the Date/Time Bar opens a list of all previously saved 

calibration results. The user can scroll through the list to select the desired calibration date, and 

then press OK to view the prior calibration results (Figure 2.27). 

 

 



20170418 ATOM SGA Manual  TraceS-1000 User’s Manual 

TraceS-1000 User’s Manual   Page | 53 

Figure 2.27 – Historical Calibration Results Dropdown Menu 

 

The central section provides individual peak areas and concentrations, as well as the average of 

all completed cycles run. The Value Used section contains the final values selected for use. In 

other words, even though the analyzer computes the average area for Check Zero and Check 

Span concentrations in the Check Calibration process, the user may have used an alternate value 

for computing the “Calculated and Used” RF. User modification of these values will be evident if 

there is a difference between Average values and “Value Used”. 
 

Section 2.3.2 Cycle Graph Mode  
 
The Cycle Graph menu is a graphical representation of the detector signal as it occurs in real time 

during the Run Cycle. This screen allows the user to ascertain general characteristics such as 

baseline noise, peak profile and peak integration period from one or more sequential analysis 

(Figure 2.28). 

To access the Cycle Graph Screen press, View > Cycle Graph Mode. 
 

 
Figure 2.28 – Cycle Graph Mode Screen for Stream 1 
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Cycle Graph  
 

The Cycle Graph is a typical X-Y graphical display plotting detector counts versus time in 
seconds. Individual data points are computed and plotted for each second of the 
programmed cycle time. 
 
The graph also displays the Start and Stop time of the Peak Integration Window as 
denoted by the two vertical red lines. The software is designed to sum all baseline 
corrected areas within this window, or between 20 and 70 seconds in this example.  
 
A feature only available when one series is selected for plotting in Display Cycles is a 
vertical line cursor with an associated text box. The user may press anywhere within the 
plot area to activate this cursor, causing an X-Y text box to appear. The user may move 
the cursor anywhere along the signal to display the time-counts values of the nearest data 
point. The text box will not appear until there is recorded data within the current Run 
Cycle (Figure 2.29). 

 
Figure 2.29 – Viewing Specific Data Points on Cycle Graph 

 
Set Min and Set Max 
 

These buttons allow the user to change the minimum and maximum scaling of the Cycle 
Graph. The scaling feature enables significant flexibility of the displayed data, depending 
on user preference.  

 
Display Cycles  
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This button allows the number of cycles to be displayed as series, allowing graphical 
comparison of previous Run Cycles. Any number of sequential analyses may be chosen 
which are represented as Series 1-7 on the right side of the Cycle Graph.  

 
The Series colors have been selected to convey temporal information related to the Run 
Cycle in the order in which the analyses occurred. The series colors are as follows: 

 

Series 1 Red  

Series 2 Orange  

Series 3 Yellow  

Series 4 Green  

Series 5 Light Blue  

Series 6 Dark Blue  

Series 7 Purple  

The most recent series will always be red. As additional cycles are run, the color for the displayed 
series are scrolled such that the data represented by a particular color is always shifted to the 
next Series color at the beginning of a new cycle (Figure 2.30). 
 

 
Figure 2.30 – Cycle Graph Displaying Multiple Trace Concentration Peaks 

 
NOTE: If there is more than one series selected to be graphed, the previously described vertical 
cursor displaying the time and detector counts is disabled. 
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Current Value  
 
 This shows the current value as it rises and falls throughout the cycle period. 
 
Current Cycle Time 
 

This is the same number that is displayed on the Home Screen and shows the current cycle 
time for convenience.  
 

Section 2.3.3 Process Results  
 

The Process Results menu screen allows the user to view analysis results in percent concentration 
of completed process samples run (Figure 2.31). 
 
Open this screen by pressing View > Process Results. 
 

 
Figure 2.31 – Process Results Screen for Stream 1 and Stream 2 

 
The Process Results menu screen displays a list of the last 10 samples run. The most recent 
sample is listed at the top and results will scroll down as subsequent samples are run.  
 
The average concentration is displayed at the bottom of the table and includes the selected 
number of most recent runs. To select the number of runs included in the average, press the 
button adjacent to “Conc. Average” to open a select text box. 
 
NOTE: If concentration is chosen as an output of the analyzer, the average concentration 
calculated above is outputted. To output the concentration for each single run (as displayed on 
the home screen), select a Conc. Average of 1. 
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Section 2.4 Windows 
 
The Windows menu screens allow the user to organize any open menus.  
 

 
Figure 2.32 – Windows Dropdown Menu 

 

Due to the relatively large size of the available menus in relation to the size of the TraceS-1000 

touchscreen computer display, the only practical arrangement option is to cascade open 

windows. The Cascade function stacks menu screens utilizing the title bar for reference in the 

order they were opened. Selecting either Arrange All or Cascade options generates identical 

arrangement of menu screens, such as in the example below. (Figure 2.33) 

 

 
Figure 2.33 – Cascaded Menus 

 

Section 2.5 Help 
 

The Help section contains a single drop down selection menu (See Figure 2.34). 
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Figure 2.34 – Help Dropdown Menu 

 

To access the About Us menu press Help > About Us (See Figure 2.35). 
 

 
Figure 2.35 – About Us Screen 

 
The About Us Menu Screen displays information regarding the software version and associated 
release dates of three separate programs. The GUI, Detector and Scanner programs have distinct 
functions, but work in conjunction with each other to provide comprehensive control of the 
TraceS-1000 instrument and user interface.  
 

 
 
 
 
 
 
 

Section 3 – Basic Maintenance Guide 
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Section 3.1 Combustion Tube Replacement 
 

 

Begin by loosening the two screws indicated above inside the furnace chamber 

 

 

Gently swing the furnace outward. The furnace incorporates a special roller bearing for support 

and allows near effortless movement. 
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Loosen and detach combustion tube inlet and outlet fittings 

 

 

Fittings shown detached from combustion tube  
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Press and rotate the insulator clamp to allow access to the ceramic insulators 

 

 

Carefully remove both ceramic insulators  
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The combustion tube is now ready to be removed 

 

 

Carefully and slowly remove the combustion tube from the furnace 

Insert a new combustion tube, replace ceramic insulators, rotate and secure insulator clamp. 

 Re-attach combustion tube fittings, carefully roll furnace back in place and retighten screws.  
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Section 3.2 Furnace Replacement  
 

 

Begin by loosening both screws indicated above 

 

 

Using a small screwdriver to compress the terminal spring, remove both heater wires 
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Heater wires removed from terminals 

 

 

Repeat the above and remove both thermocouple wires from the terminals 
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Carefully lift the furnace up off of the pin hinges and remove from the furnace chamber 

 

 

Remove all four furnace mount screws to complete the disassembly process 
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Section 3.2 Membrane Dryer Replacement 
 

 

Orient the permeation tube fitting as shown 

 

 

Begin by placing the tubing inside of the mounting bracket 
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Continue winding, stacking the dryer layer upon layer 

 

 

Until dryer has been completely wound 
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After winding, the Perma Pure Dryer should look like this 

 

 

Next, lift tubing to push the first fitting back inside  
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Then bring to the top against the mounting bracket 

 

 

Using a 7/16” wrench, loosen and remove the 1/8” fittings on both ends 
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The dryer should look like this after both end fittings are removed 

 

 

Next, loosen but do not remove the ¼” inch fitting on both ends 
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Holding the inner tube, rotate the T-fitting to point toward the inside on both ends 

 

The dryer should then look like this 
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Re-tighten both ¼”T-fittings 

 

 

Lastly, re-attach both 1/8” inch end fittings  

The Membrane dryer is now ready to be reinstalled on the analyzer. 
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Section 3.3 Shinko Temperature Controllers  
 

The TraceS-1000 has three separate temperature zones controlled by Shinko Model DCL-33A 
temperature controllers, which include the Sample Enclosure, Combustion Furnace and Main 
Enclosure. These DIN rail mounted controllers are approximately located in the center of the 
Main Enclosure, and are underneath the right-hand side of the detector module. (Figure 3.1)  
 

 
Figure 3.1 – Shinko Temperature Controllers 

 
Factory recommended temperature set-points are as follows: 
 
1. Sample Enclosure: 70°C (or sufficient to prevent any condensation of sample) 
2. Combustion Furnace: 1050°C (minimum for complete sample combustion and Sulfur 

conversion) 
3. Main Enclosure: 30°C (may be increased to 40°C if necessary in warmer 

environments) 
 
The temperature controller settings have been programmed into the instrument installed 
controllers at the factory and are included in this manual for reference purposes only. The 
following page contains factory settings for the three Model DCL-33A Temperature Controllers 
for the TraceS-1000. (Section 3.3.1) 
 

For complete instructions and menu navigation for the parameters below, refer to the Shinko 
DCL-33A Indicating Controller Instruction Manual. 
 

Note: Although autotuning is a routine function which is part of analyzer testing at the factory, it 
is recommended that subsequent autotuning of these controllers is performed in the field for 
best results.  
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Section 3.3.1 Shinko Temperature Controller Programmed Settings  
 

1 Desired value 70.0 1050 30.0

1 Auto tuning perform/cancel

2 OUT propotional band. Auto calc Auto calc Auto calc

3 Intergral time Auto calc Auto calc Auto calc

4 Derivative time Auto calc Auto calc Auto calc

5 Anti-reset windup Auto calc Auto calc Auto calc

6 OUT propotional cycle Auto calc Auto calc Auto calc

7 Manual reset Skip Skip Skip

8 Alarm value Skip 25 Skip

9 Heater burnout alarm valve Skip Skip Skip

10 Loop break alarm time 0 0 0

11 Loop break alarm span 0.00 0 0.00

1 Set value lock

2 Sensor correction 0.0 0.0 0.0

3 Communication protocol

4 Instrument number 0 0 0

5 Communication speed

6 Parity Skip Skip Skip

7 Stop bit Skip Skip Skip

1 Input type

2 Scaling high limit 80.0 1100 40.0

3 scaling low limit 60.0 1000 20.0

4 Decimal point place Skip Skip Skip

5 PV filter time constant 0.0 0.0 0.0

6 OUT high limit 100 100 100

7 OUT low limit 0 0 0

8 OUT ON/OFF hysteresis Skip Skip Skip

9 Alarm type

10 Alarm action Energized/De-energigized Skip Skip

11 Alarm HOLD function Skip Skip

12 Alarm hysteresis Skip 5.0 Skip

13 Alarm action delay timer Skip 0 Skip

14 Direct/Reverse control

15 AT bias 20.0 20 20.0

16 SVTC bias 0.0 0 0.0

17 Output status when input abnormal Skip Skip Skip

18 Controller/Converter Skip Skip Skip

Auxillary function setting mode 1

Auxillary function setting mode 2

Main setting mode

Sub setting mode

Parameter Function

Sample 

Enclosure 

Heater

Combustion 

Furnace 

Heater

Main 

Enclosure 

Heater

Step
7-Segment

 Display
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Section 3.4 Shinko Signal Conditioners 
 

The TraceS-1000 has two analog outputs that utilize Shinko, Model SAU-1 DIN rail mounted Signal 

Conditioners. These modules have been configured to deliver a 4-20mA output, with a 0-1VDC 

input signal. These controllers are located in the center of the Main Enclosure, to the left of the 

three temperature controllers. (Figure 3.2)  

 

The intended analyzer variable for the controller input is selected from the Output Settings of 

the SGA analyzer software utilizing the computer touchscreen. The variable can then be ranged 

within the same menu as desired, which will deliver the 0-1VDC signal from the SP-2000 Signal 

Processing Detector board DAC to the Shinko Signal Conditioner input. (Section 3.4.1) 

 

 
Figure 3.2 – Shinko Signal Conditioners 

 

The two Signal Conditioning Modules have been programmed by the factory for the following: 

 

  Input  Output  Reading 

Channel A: 0-1VDC 4-20mA  0-9999 (ppm when Conc. is the variable, ranged 0-1%) 

Channel B: 0-1VDC 4-20mA 0-9999 (ppm when Conc. is the variable, ranged 0-1%) 
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Section 3.4.1 Shinko Signal Conditioner Programmed Settings 
 

 
 

   

1 Output zero 0.00 0.00

2 Output span 0.00 0.00

3 Output 2 zero Skip Skip

4 Output 2 span Skip Skip

5 Potentiometer zero input Skip Skip

6 Potentiometer zero output Skip Skip

1 Set value lock

2 Input

3 DC voltage input range

4 Decimal point place 0 0.00

5 Output 0% value 0 0.00

6 Output 100% value 9999 50.00

7 Filter time constant 0.0 0.0

8 Sensor correction 0 0.00

9 Output

10 Output Normal/Reverse

11 Burnout Skip Skip

12 Display

13 Indication time 00.00 00.00

Parameter Function

Setup mode 

Adjustment mode

Ch A

(4-20 mA)

Ch B

(4-20 mA)
Step

7-Segment 

Display
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Section 3.5 Updating Software 
 

The TraceS-1000 computer software and detector firmware are easily upgraded as revisions 

become available from the factory. The GUI and scanner software reside on the solid-state hard 

drive of the touchscreen computer. The detector firmware can be upgraded utilizing what is 

known as a bootloader program, which is accessible from the program icon located on the 

desktop. Future updates may include changes to any, or all embedded programs. Instructions for 

how to load and update the TraceS-1000 software to include the latest released revisions are 

included below. 

 

 

Section 3.5.1 Installing the GUI and Scanner software using the installer program 

 

Initial setup: 

 
1. Stop the analysis/cycle (if running) 

 

2. Before closing the atom.exe software note the information underlined in red. The 

settings/values shown in figure 3.1 are for example only and will be different for each 

user. 

 

 
Figure 3.1 

3. Close atom.exe  

 

4. In the GUI go to Settings>Detector Settings and note the PMT HV value. 

 

5. Close GUI 

 

6. Insert the USB thumb drive provided by ATOM in the USB2.0 port of the SGA computer. 
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Installer: 

 
1. Delete the folder C:\Apps from the SGA computer. 

 
2. Delete the shortcut for the GUI from the Desktop and the Taskbar 

 
3. Open the folder “Installers” from the thumb drive. 

 
4. Double click “ATOM_SGA_Redist.exe ” 

 
5. Click Next (Figure 3.2) 

 

 
Figure 3.2 
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6. Click Install (Figure 3.3). The installation will take approximately 5 minutes. 
 

 
Figure 3.3 

 
7. Click Close (Figure 3.4) 

 

 
Figure 3.4 

 

8. Double click ATOMSGA_GUI.exe from the Installers folder on the thumb drive. 
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9. Click Next (Figure 3.5) 

 

 
Figure 3.5 

 

10. Click Install (Figure 3.6) 
 

 
Figure 3.6 
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11. Click Close (Figure 3.7) 
 

 
Figure 3.7 

 

12. If needed reload the .HEX file to the SP-2000 board as described in following section 
 

13. Restart the computer. 
 

14. Go to Start>All Programs>ATOM>ATOM GUI and place a shortcut for the GUI on the 
Desktop and Taskbar. 

 
15. Check the PMT HV value and change it back to the original value.  

 

Section 3.5.2 Bootloader Procedure for Detector Board 

  
This procedure replaces the embedded HEX file firmware program in the SP-2000 Signal 

Processing detector board microprocessor. This file must be installed separately as it cannot load 

automatically without accessing and utilizing the Microchip bootloader program per the 

following instructions below. Before beginning this procedure, the user will either need the 

required HEX file to already be on the computer. 
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Initial setup: 

 
1. Stop the analysis/cycle (if running) 

 

2. Before closing the atom.exe software note the information underlined in red (Figure 3.8). 

The values shown in figure 3.8 are for example only and will differ for each user. 
 

Figure 3.8 

3. Close atom.exe  

 

4. Close GUI 

 

Moving files: 

 
1. In windows explorer open the folder C:\ATOM! 

 

2. Delete the following files by moving them to the recycle bin 

• atom.exe 

• MAIN18F8722.HEX 

 

3. Copy the followings files to the folder C:\ATOM! 

• atom.exe 

• ATOM_CFG03.txt 

• P2000.SGA.X.production.HEX 

 

Transferring the HEX file from C:\ATOM! to the SP-2000 board: 

 
1. Open the bootloader (Figure 3.9) software AN1310 from the Desktop of the SGA 

computer. From the main menu go into Program>Settings (Figure 3.10) 

 

 
Figure 3.9: Bootloader Icon 
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Figure 3.10 

 

2. On the Settings screen select a baud rate of 115200. The COM Port number will be 

identical to the Detector COM (refer to Figure 3.11), in this example 8. The allocated COM 

port may also be found in Control Panel>Device Manager (Figure 3.12). Make sure the 

FLASH Program Memory is checked and then click OK 

 

 
Figure 3.11 
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Figure 3.12 

 

3. Press the green Run Mode button on the bootloader screen (Figure 3.13). At the bottom 

right hand side of the screen the “Connected” status will appear as well as the COM Port 

number. 

 

 
Figure 3.13 
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4. Press the blue Break/Reset Mode button (Figure 3.14). The bottom status bar will request 

resetting the SP-2000 board. 

 

 
Figure 3.14 

 

5. On the SP-2000 board inside the analyzer (Figure 3.15), press and hold for 2 seconds the 

Reset button. The SP-2000 board may be found behind the Detector assembly. 

 

 
Figure 3.15 
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6. Press the red Break Mode button (Figure 3.16). 

 

 
Figure 3.16 

 

7. From the main menu select File>Open (Figure 3.17) 

 

 
Figure 3.17 
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8. Select the P2000.SGA.X.production.hex file located in C:\ATOM! and click Open (Figure 

3.18). This new software file that was previously copied in folder (Refer to Step 3 of the 

Moving files section). 

 

 
Figure 3.18 

 

9. The bootloader screen will show new hexadecimal values. Click the Write Device button 

(Figure 3.19). 

 

 
Figure 3.19 
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10. The bootloader software will replace the old firmware in the SP-2000 board with the new 

one. The bottom status bar will indicate “Write complete” when this step is done (Figure 

3.20). 

 

 
Figure 3.20 

 

11. Close the bootloader software (Figure 3.21). 

 

 
Figure 3.21 



20170418 ATOM SGA Manual  TraceS-1000 User’s Manual 

TraceS-1000 User’s Manual   Page | 89 

 

12. Press and hold for 2 seconds the Reset button on the SP-2000 board to finish this 

sequence. 

 

Restoring communication settings using the configuration file: 
 

Upon completion of the previous steps, the communications settings previously entered by the 

end-user will be returned to the default parameters. In order to re-establish communication with 

the analyzer, those parameters must be changed back to the values prior to the update. 

 
Open the file ATOM_CFG03.txt located in C:\ATOM!. All the settings required in this section can be 

obtained from step 2 of the initial setup (Figure 3.1). 

The first line with five single digit integers separated by commas is used to set up the MODBUS 

communications settings. Do not add spaces after commas. 

The standard configuration is: 8,001,4,0,002,0. Below is the description of each integer: 

8 = Detector Com Port Number (Serial port on the SGA computer that communicates with the SP-2000 

board) 

001 = Detector ID Number (001 by default, must not be changed) 

4 = Client Com Port Number (COM port of SGA computer assigned to RS485/422) 

0 = Client Baud rate (where: 0=9,600; 1=19,200; 2=57,600; 3=115,200) 

002 = Client ID (valid range for station ID assignment: 002-126) 

0 = Analyzer information logging for troubleshooting (0=off, 1=on) 

Save the .txt file after any changes. Open atom.exe and GUI. Upon successful update the message 

activity counter indicated by Msg# will keep increasing (Figure 3.22). 

 
Figure 3.22 
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Section 4 – TraceS-1000 MODBUS Digital 
Communications  
 

Section 4.1 Customer Connections 
 
The TraceS-1000 System supports both RS485 half-duplex and RS422 full-duplex communication 

for client access to the ATOM Database. User communications cable should be connected as 

specified below, depending upon COM type. 

The COM 4 Port on the touchscreen computer which includes a DB-9 connector and associated 

label with communication signals is assigned to the following Pins: 

 RS-485 RS-422 

1 TX- X X 

2 TX+ X X 

3 RX-  X 

4 RX+  X 

5 GND X X 

 

The DB-9 pins are connected to a terminal strip within the TraceS-1000 Main Electronics 

Enclosure. Locate the User Connection Terminal Strip within the SGA cabinet 

 

 

For MODBUS RS-485: Connect to terminals 1,2,5 



20170418 ATOM SGA Manual  TraceS-1000 User’s Manual 

TraceS-1000 User’s Manual   Page | 91 

For MODBUS RS-422: Connect to terminals 1,2,3,4,5 

Section 4.2 Communication Settings 
 

Once customer connections have been wired, click on the ATOM Icon to open the ATOM 

program, which will display the main menu. 

 

 
 
Click File to reveal a drop down menu.  

The Scanner Program is used to configure the COM Ports. 
Other Menu selections allow assignment of Client Station ID and 

Baud Rate. 

Select Client COM 

 

 

The Client COM selection allows the user to specify the Client COM port and Baud Rate. 

Highlight the desired COM port (The label placed on the back of the SGA computer shows COM4 

port number for RS-485/422) for the Client connection, and then set the desired baud rate to match 

Client requirements. Press OK. 
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Click on File\ Client ID 

Select the station ID for the Client system. This will be the station ID for the 

MODBUS algorithm used by the ATOM TraceS-1000 system. The valid range 

for station ID assignment is 002-126. By default, Client ID should be set to 2. 

 

 

Close and reopen ATOM.exe for the settings to take effect 

 

 

 

The ComPort number, baud rate and client ID selected in above steps will be displayed in the 

main screen of ATOM.exe. Upon successful communication link with the client system the 

message activity is indicated by Msg#.  

 

 

 

Section 4.3 Modifying communication settings using the configuration 

file 
 

The communication settings described above can also be changed by modifying the configuration file. To 

do so, open the file ATOM_CFG02.txt located in C:\ATOM! 

The first line with five digit integers separated by commas is defined as follow: 8,001,4,0,002 

Where: 

8 = Detector Com (This serial port on the SGA computer communicates with the Detector board) 

001 = Detector ID 

4 = Client Com (This is the COM port of SGA computer designated for RS485/422) 

0 = Client Baud rate (where: 0=9.6kb, 1=19.2kb, 2=57.6kb, 3=115.2kb) 

002 = Client ID (valid range for station ID assignment is 002-126) 
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After any changes, save the .txt file and restart ATOM.exe for changes to take effect. 
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Section 4.4 MODBUS Function Code Description 
 

The ATOM TraceS-1000 is a “MODBUS Slave” while the client is the “MOSBUS Master”. All commands 

supported are 8-byte length as described below: 

 

|Address ID| Function code |Start Ho|Start Lo|Data #pts Ho|Data #pts Lo|CRC0|CRC1| 
 
Where: 

• Address ID is the address that the station ID ATOM software must find to start a message. 

• Function code is a value 1 to 6 declaring what function is to be performed (see below). 

• Start HO is the starting register higher order 8-bits. Start LO is the starting register lower order 
8-bits.These two bytes are concatenated to create a 16-bit number used in the data base. 

• Data #pts Ho and Data #pts Lo are two bytes concatenated to specify the number of registers 
designated in the MODBUS message. 

• CRC0 and CRC1 are two bytes concatenated to specify the CRC of the MODBUS message. 
Security is maintained by computing the CRC of the message first six bytes and comparing to the 
last two bytes for a match. A message is not processed if the two CRC’s do not match. 

 

• Function code 1: Read Relay coils (R1-R32 range). 

• Function code 2: Read Input Status Registers (R10001-R10032 range). 

• Function code 3: Read discrete 16-bit holding Registers (R40001-R40040 range). 

• Function code 3: Read discrete 32-bit holding Registers (R40041-R40120 range) where: R40041-
42 is the first par, R40119-120 is the last pair. 

• Function code 4: Read output 32-bit register pairs (R3001-R30082 range) where: R30001-02 is 
first pair, R30081-R30082 is last pair. 

• Function code 4: Read output 16-bit registers (R30083-R30120 range) where: range is 16-bit 
registers. 

• Function code 5: set relay coil register (R1-R40). 

• Function code 6: preset single holding register (R40001-R40120). 
 
The double registers specified in function code 3 and 4 must be recognized as 32-bit data to interpret it 
properly. 
 

Section 4.5 Reading Algorithm 
 

The MODBUS data is typically a near continuous stream of data packets from the Client. The ATOM 

software is self-aligning regardless of where it starts listening to packets. This is accomplished by starting 

with an index of zero. The byte read must equal the Station ID if the index is zero. If not, the alignment 

procedure begins again without incrementing the index. Alignment is achieved within 8 characters of a 

packet for the ATOM TraceS-1000. When a character read does equal the ID, the index is advanced from 

0 to 1. The next character read must equal an allowable function code (1-6). If there is no match the index 

is reset to 0. Under this scenario, the reception of packets will self-synchronize. If we have a match on the 

first and second byte, read the next 6 bytes. At this point we have 8 bytes in a receive register. Perform a 

CRC on the first six characters and compare with the 7th and 8th characters. There must be a CRC match to 

process the received packet. If there is no match, the index is again reset to 0 and the process of data 
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capture and qualification repeats. Upon detection of a complete and valid packet the received 8-byte 

packet is transferred to private processing area. The “Save Packet” function is called which executes a 

function (1-6) as defined by the function code byte in the 2nd byte of the saved packet. The ATOM software 

creates a reply message for the Client and transmits it back to the client. A message stream resembles the 

image below showing the command on the left and the response on the right. 

 

 

Response time is approximately 10ms after the packet is decoded before a reply message is sent. 

 

Example of reading a single unsigned 32-bit register 
 

In the example below, registers pair R30169 and R30170 are the ppm value. Use function code 4 with an 

offset of 68 in the MODBUS message to read it. 

 

Example MODBUS query: 02 04 00 44 00 02 31 ED 

 

Where: 

02 = ID 

04 = Function Code 

00 44 = address offset = 68 

00 02 = number of registers requested 

31 ED = CRC 

 

Example of MODBUS response, returns 4 bytes from offset 68 : 02 04 04 00 07 B1 84 0D 76 

 

Where: 

02 = ID 

04 = Function Code 

04 = Byte Count 

00 07 B1 84 = 504,196 ppm 

0D 76 = CRC 

 

 

Section 4.6 ATOM Instrument SGA1000 MODBUS Map  
 

The MODBUS Data Model presents six database areas that SGA1000 data may be read from or written to. 

The areas are defined as follows: 

ATOM MODBUS Database Model 

Database Area Name Register Designation Default Data Type 

1 Coils/Boolean 00001 – 00032 Boolean 

2 Input Status 10001 – 10040 Boolean 
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3 Input Register pairs 30001 – 30080 32-bit Integer 

4 Input Register 30083 – 30120 16-bit Integer 

5 Input Register 30121 – 30158 16-bit Integer 

6 Input Register pairs 30165 – 30274 32-bit Integer 

7 Holding Register 40001 – 40040 16-bit Integer 

8 Holding Register pairs 40041 – 40120 32-bit Integer 

9 Holding Register pairs 40121 – 40200 32-bit Integer 

10 Holding Register 40201 – 40240 16-bit Integer 

 

Each discrete data element within the MODBUS database is called a register. Register addressing resolves 

the database area in which it resides as well as the element offset within the area. For example, the 

register address of 30083 indicates the integer value stored in register 83 within the Input Registers data 

base area. MODBUS address 00004 indicates the current Boolean value in register 4 of the Discrete Coil 

Register area in the data base. 

 

Another aspect of the MODBUS register convention is that some registers are Read-Only from the Host 

system while other areas are Read/Write. 

• The Input Status Registers (1xxxx) and the Output Status registers (3xxxx) are Read-Only registers. 
The Host system is only able to read the values placed into these register areas. 

 

• The Coil Registers (0xxxx) and the Holding Register (4xxxx) are Read/Write registers. The host has 
read/write access to the registers in these areas. These areas are where Command and Operating 
Parameter values are written from the Host system. Read only data from the field unit can be 
placed into these registers as well. 

 

Registers in 3xxxx and 4xxxx range have segments dedicated for 32-bit Integers. These registers require 

two sequential 16-bit registers. See description in the map. 

This data base exists to allow communication from/to the SGA1000 to the ATOM Scanner/GUI program 

and a RS-485 link for a MODBUS client system. 

Controls at the ATOM Scanner program allow the administrator to program the COM Port, Baud Rate and 

MODBUS ID for the ATOM Scanner and the RS485 Client link.  

Client Access: Although the entire ATOM database is available, a client may only have interest in certain 

data areas. Here is a selection of typical monitor points. 

Standby, Process, Calibration, Validation Status and concentration to monitor 

10003 Process State (Stream 1) 1=Process on Stream 1 (Boolean) 

10007 Validating 1=Validation in Process (Boolean) 

10008 Alarm State Alarm Status (Boolean) 

10019 Purging 1=Purging in Process (Boolean) 

10024 Calibrating 1=Calibration in Progress (Boolean) 

10025 Running 1=Status Run Mode (Boolean) 
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10026 Holding S1=status IDLE (Boolean) 

10032 Fresh Data “1” indicates Fresh Data (auto cleared at the end of next 
peak acquisition (about 70 seconds has elapsed) while in 
Process state) 

30069-
30070 

Ppm (Cycle Concentration 
results ) 

concentration in ppm this current cycle (32-bit integer) 

 

Minimal client monitoring algorithm: 

The client could read 10001-10040 (5-bytes) twice per minute for changes in system status. Registers 

30069-30070 could be read when the fresh data flag sets. At least 70 seconds elapses before “Fresh Data” 

self clears for the next cycle. 

Discrete Coil Registers 
Range 00001-00032 

R# Mnemonic Description (Boolean Commands) 

1 New SRN  1=New Sequential Record Number written 

2 ARun  Start/Stop a RUN; 0=OFF, 1=ON 

3 Calibrate Check Zero Start/Stop a Calibrate Zero Function 

4 Calibrate Check Span Start/Stop a Calibrate Span Function 

5 Calibrate Validate Start/Stop a Validate Function 

6 Manual Zero Set 0=idle, 1=manual zero set 

7 Ignore Data  Analyzer Online =0; Analyzer Offline =1 

8 Reserved  

9 Calculate RF 1=Save and Calculate a Response Factor 

10 Override 1=Purge Override ON; 0=OFF 

11 BL_Set 1=takes current detector reading to 
calculate offset 

12 BL_Enable 1=Base Line Enable for “Zero Baseline” 

13 Lamp State  Lamp On/Off Control; 0=OFF, 1=ON 

14 PMT State PMT On/Off Control; 0=OFF, 1=ON 

15 Auto Cal Enable 1=Automatic Calibrate Enable 

16 Sync Calendar 1=synchronize calendar to the PC 

17 SV State DO S/V (Sample Valve) 0=OFF, 1=ON 

18 SSO State DO SSO (Sample Shut Off) 0=OFF, 1=ON 

19 Stream 1 State DO Process Stream 1 (test control of DO)  

20 Stream 2 State DO Process Stream 2 (test control of DO) 

21 Zero State DO Zero (test control of DO) 

22 Span State DO Span (test control of DO) 

23 Validate State DO Validate (test control of DO) 

24 Alarm State DO Alarm Status (test control of DO) 

25 Playback Control of recorded data playback 0=OFF, 
1=ON 

26 Auto Cal Event Not user programmable 

27 Set Lock Not user programmable 
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28 Data Ready Not user programmable 

29 Cal Parm Change Is set to “1” if any cal parameters have 
been modified 

230 Historical Not user programmable 

31 Reserved  

32 Check Sum Request Set to “1” to request Checksum from Atom 

33 Stream 1 Enable 1=Stream 1 selected/running  

34 Stream 2 Enable 1=Stream 2 selected/running  

  

Discrete Input Status Registers 
Range: 10001-10056 

R# Mnemonic Description (connected to physical outputs) 

10001 SV State Inject / Vent Valve (S/V) Status 

10002 SSO State Sample Shut Off / Vent (SSO) Status 

10003 Stream 1 State  Process Stream 1 Status 

10004 Stream 2 State  Process Stream 2 Status 

10005 Zero State  Zero calibration Status 

10006 Span State  Span calibration Status 

10007 Validate State  Validate calibration Status 

10008 Alarm State Alarm Status 

 

R# Mnemonic Description (8 bits mapped to physical 
inputs) 

10009 DI1 Digital Input 1 

10010 DI2 Digital Input 2 

10011 DI3 Digital Input 3 

10012 DI4 Digital Input 4 

10013 DI5 Digital Input 5 

10014 DI6 Digital Input 6 

10015 DI7 Digital Input 7 

10016 DI8 Digital Input 8 

 

R# Mnemonic Description (Boolean Status) 

10017 Overriding 1=currently in Purge Override; 0=not in 
Purge Override 

10018 New Cycle Request Not user programmable 

10019 Purging 1=Purging in Process 

10020 Check Sum Complete 0=currently performing or not yet 
performed checksum; 1=has completed a 
checksum 

10021 BL_Corrected Data has been offset by baseline corrected 
value 

10022 Logging Logging to Data Base 
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10023 Reserved  

10024 Calibrating 1=Calibration in Progress 

10025 Running 1=In Run Mode 

10026 Holding 1=Status IDLE 

10027 Stop Pending Indicates that Atom will go into HOLD state 
at end of run 

10028 Injecting 1=Inject Event (sample being injected) 

10029 Fresh Reading 1=new reading posted 

10030 Event Base Line 1=Event Base Line acquisition 

10031 Event Peak 1=Event Peak acquisition 

10032 Fresh Data 1=Fresh Data available 

10033 MFC1 Status Not available 

10034 MFC2 Status Not available 

10035 TC1 Status Not available 

10036 TC2 Status Not available 

10037 Span Status Not available 

10038 Reserved  

10039 Stream 1 Status Indicates alarm condition of stream 1 

10040 TC3 Status Not available 

10041 Check Sum Valid 1=valid checksum; 0=error  

10042 Block Ready 0 Not user programmable 

10043 Block Ready 1 Not user programmable 

10044 Stream 1 State 1=currently running; 0=not currently running 

10045 Stream 2 State 1=currently running; 0=not currently running 

10046 Process State 1=currently running; 0=not currently running 

10047 Calibrate State 1=currently running; 0=not currently running 

10048 Stream 2 Status Indicates alarm condition of stream 2 

10049 Zero Signal 1=selected and in queue 

10050 Span Signal 1=selected and in queue 

10051 Validate Signal 1=selected and in queue 

10052 User Halt Signal 1=selected and in queue 

10053 User Start Signal 1=selected and in queue 

10054 Reserved For Q Not available 

10055 Reserved For Q Not available 

10056 Reserved For Q Not available 

 

Discrete Output Registers 
Range: 30001-30120 

R# Mnemonic Description (32-bit RO registers) 

30001-30036 Reserved  

30037-30038 Applied uV Applied Baseline offset in microvolts  

30039-30040 BL Temp Corrected Not available 

30041-30042 Reserved  

30043-30044 MFC1Value Mass Flow Controller 1 Value 

30045-30046 MFC2Value Mass Flow Controller 2 Value 
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30047-30048 TC1 Value Temperature Controller 1 Value 

30049-30050 TC2 Value Temperature Controller 2 Value 

30051-30052 TC3 Value Temperature Controller 3 Value 

30053-30054 TOD Time of Day (secs since midnight) 

30055-30056 Span Cal Avg PPM Not available 

30057-30058 PMT ave PMT average (signed 32-bit) 

30059-30060 Elapse Seconds Seconds elapsed since start of cycle 

30061-30062 Reserved  

30063-30064 PD average Photo Diode 1 sec average 

30065-30066 Base Line Average baseline average in detector counts 

30067-30068 Area Of Peak Stream 1 Stream 1 peak area in detector counts 

30069-20070 Cycle ppm concentration in ppm of current cycle 

30071-30072 mV_Out PMT reading in millivolts  

30073-30074 uV_Out PMT reading in microvolts 

30075-30076 Area Of Peak Stream 2 Stream 2 peak area in detector counts 

30077-30078 Reserved  

30079-30080 Cycle_ppb concentration in ppb of current cycle 

30081-30082 Reserved  

 

R# Mnemonic Description (16-bit RO registers) 

30083 Reserved  

30084 PCT_FS_DAC1 % of Full Scale for DAC1 

30085 TC77_Sensor Temperature in deg C (scaled) 

30086 Demo Code Value between 0-3; selects a preset conc for 
playback 

30087 Cycle# Number of current cycle 

30088 Warn States Bit defined system warnings 

30089 Numbr Cycles Number of cycles completed 

30090 Alarm Status Bit defined results of warn/alarm tests 

30091 Reserved   

30092 Version Num Firmware version ID 

30093 PCT_FS_DAC2 % of Full Scale for DAC2 

30094 Date Code Days since 1-1-1900 – 32768 (s/w release) 

30095 Num of Cal Cycle Number of Calibration Cycles set to run 

30096 Override Timer Secs remaining in cabinet purge override 

30097 Numbr Cal Cycles Cycle number being run 

30098 Alarm States Bit defined system warnings 

30099 Stream 1 Progress Number of current cycle being run out of 
total requested 

30100 Stream 2 Progress Number of current cycle being run out of 
total requested 

30101 Density Reading S1 not applicable 

30102 Density Reading S2 not applicable 

30103- 
30120 

Reserved   
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R# Mnemonic Description (32-bit RO registers) 

30121-30122 PA1_S2 (Stream 2-1 Area) Concentration for Stream 2 Peak Area 1 –
scrolling array of 10 concentration values in 
ppm x 100. Oldest data if the array over-
written each cycle. 

30123-30124 PA1_S2 (Stream 2-2 Area) Concentration for Stream 2 Peak Area 2 

30125-30126 PA1_S2 (Stream 2-3 Area) Concentration for Stream 2 Peak Area 3 

30127-30128 PA1_S2 (Stream 2-4 Area) Concentration for Stream 2 Peak Area 4 

30129-30130 PA1_S2 (Stream 2-5 Area) Concentration for Stream 2 Peak Area 5 

30131-30132 PA1_S2 (Stream 2-6 Area) Concentration for Stream 2 Peak Area 6 

30133-30134 PA1_S2 (Stream 2-7 Area) Concentration for Stream 2 Peak Area 7 

30135-30136 PA1_S2 (Stream 2-8 Area) Concentration for Stream 2 Peak Area 8 

30137-30138 PA1_S2 (Stream 2-9 Area) Concentration for Stream 2 Peak Area 9 

30139-30140 PA1_S2 (Stream 2-10 Area) Concentration for Stream 2 Peak Area 10 

30141-30142 PA1_S1 (Stream 1-1 Area) Concentration for Stream 1 Peak Area 1 –
scrolling array of 10 concentration values in 
ppm x 100. Oldest data if the array over-
written each cycle. 

30143-30144 PA1_S1 (Stream 1-2 Area) Concentration for Stream 1 Peak Area 2 

30145-30146 PA1_S1 (Stream 1-3 Area) Concentration for Stream 1 Peak Area 3 

30147-30148 PA1_S1 (Stream 1-4 Area) Concentration for Stream 1 Peak Area 4 

30149-30150 PA1_S1 (Stream 1-5 Area) Concentration for Stream 1 Peak Area 5 

30151-30152 PA1_S1 (Stream 1-6 Area) Concentration for Stream 1 Peak Area 6 

30153-30154 PA1_S1 (Stream 1-7 Area) Concentration for Stream 1 Peak Area 7 

30155-30156 PA1_S1 (Stream 1-8 Area) Concentration for Stream 1 Peak Area 8 

30157-30158 PA1_S1 (Stream 1-9 Area) Concentration for Stream 1 Peak Area 9 

30159-30160 PA1_S1 (Stream 1-10 Area) Concentration for Stream 1 Peak Area 10 

30161-30162 S1_Cycle_ppb Most recent Stream 1 cycle conc in ppb 

30163-30164 S2_Cycle_ppb Most recent Stream 2 cycle conc in ppb 

30165-30166 Ppb Stream 1 1 Scrolling array of 10 values with most 
recent Stream 1 concentration in ppb in 
these registers 

30167-30168 Ppb Stream 1 2 Concentration for Stream 1 ppb 2 

30169-30170 Ppb Stream 1 3 Concentration for Stream 1 ppb 3 

30171-30172 Ppb Stream 1 4 Concentration for Stream 1 ppb 4 

30173-30174 Ppb Stream 1 5 Concentration for Stream 1 ppb 5 

30175-30176 Ppb Stream 1 6 Concentration for Stream 1 ppb 6 

30177-30178 Ppb Stream 1 7 Concentration for Stream 1 ppb 7 

30179-30180 Ppb Stream 1 8 Concentration for Stream 1 ppb 8 

30181-30182 Ppb Stream 1 9 Concentration for Stream 1 ppb 9 

30183-30184 Ppb Stream 1 10 Concentration for Stream 1 ppb 10 

30185-30186 Ppb Stream 1 ave Average Concentration in ppb of preset 
numbers of cycles for Stream 1  

30187-30188 Span ppb Cal 1 Scrolling array of 10 values with most 
recent Span concentration in ppb in these 
registers 
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30189-30190 Span ppb Cal 2 Concentration for Span ppb 2 

30191-30192 Span ppb Cal 3 Concentration for Span ppb 3 

30193-30194 Span ppb Cal 4 Concentration for Span ppb 4 

30195-30196 Span ppb Cal 5 Concentration for Span ppb 5 

30197-30198 Span ppb Cal 6 Concentration for Span ppb 6 

30199-30200 Span ppb Cal 7 Concentration for Span ppb 7 

30201-30202 Span ppb Cal 8 Concentration for Span ppb 8 

30203-30204 Span ppb Cal 9 Concentration for Span ppb 9 

30205-30206 Span ppb Cal 10 Concentration for Span ppb 10 

30207-30208 Span ppb Cal ave Average Concentration in ppb of run cycles 
for Span  

30209-30210 Checksum Output of detector firmware checksum  

30211-30212 PPBA1_S2 (Stream 2 ppb) Scrolling array of 10 values with most 
recent Stream 2 concentration in ppb in 
these registers 

30213-30214 PPBA2_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 2 

30215-30216 PPBA3_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 3 

30217-30218 PPBA4_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 4 

30219-30220 PPBA5_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 5 

30221-30222 PPBA6_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 6 

30223-30224 PPBA7_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 7 

30225-30226 PPBA8_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 8 

30227-30228 PPBA9_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 9 

30229-30230 PPBA10_S2 (Stream 2 ppb) Concentration for Stream 2 ppb 10 

30231-30232 PPBave_S2 (Stream 2 ppb) Average Concentration in ppb of preset 
numbers of cycles for Stream 2  

30233-30234 Zero Area 1 Calibrate Scrolling array of 10 values with most 
recent Zero Area in these registers 

30235-30236 Zero Area 2 Zero Calibration Area 2 

30237-30238 Zero Area 3 Zero Calibration Area 3 

30239-30240 Zero Area 4 Zero Calibration Area 4 

30241-30242 Zero Area 5 Zero Calibration Area 5 

30243-30244 Zero Area 6 Zero Calibration Area 6 

30245-30246 Zero Area 7 Zero Calibration Area 7 

30247-30248 Zero Area 8 Zero Calibration Area 8 

30249-30250 Zero Area 9 Zero Calibration Area 9 

30251-30252 Zero Area 10 Zero Calibration Area 10 

30253-30254 Zero Area Ave Calibrate Avg Area of run cycles for Zero Calibration 

30255-30256 Zero ppb 1 Calibrate Scrolling array of 10 values with most 
recent Zero concentration in ppb in these 
registers 

30257-30258 Zero ppb 2 Calibrate Concentration for Zero ppb 2 

30259-30260 Zero ppb 3 Calibrate Concentration for Zero ppb 3 

30261-30262 Zero ppb 4 Calibrate Concentration for Zero ppb 4 

30263-30264 Zero ppb 5 Calibrate Concentration for Zero ppb 5 

30265-30266 Zero ppb 6 Calibrate Concentration for Zero ppb 6 
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30267-30268 Zero ppb 7 Calibrate Concentration for Zero ppb 7 

30269-30270 Zero ppb 8 Calibrate Concentration for Zero ppb 8 

30271-30272 Zero ppb 9 Calibrate Concentration for Zero ppb 9 

30273-30274 Zero ppb 10 Calibrate Concentration for Zero ppb 10 

30275-30276 Zero ppb Ave Calibrate Average Concentration in ppb of preset 
numbers of cycles for Zero  

30277-30278 Span 1 Area Calibrate Scrolling array of 10 values with most 
recent Span Area in these registers 

30279-30280 Span 2 Area Calibrate Span Calibration Area 2 

30281-30282 Span 3 Area Calibrate Span Calibration Area 3 

30283-30284 Span 4 Area Calibrate Span Calibration Area 4 

30285-30286 Span 5 Area Calibrate Span Calibration Area 5 

30287-30288 Span 6 Area Calibrate Span Calibration Area 6 

30289-30290 Span 7 Area Calibrate Span Calibration Area 7 

30291-30292 Span 8 Area Calibrate Span Calibration Area 8 

30293-30294 Span 9 Area Calibrate Span Calibration Area 9 

30295-30296 Span 10 Area Calibrate Span Calibration Area 10 

30297-30298 Span Area Ave Calibrate Avg Area of run cycles for Span calibration 

30299-30300 Validate 1 ppb Scrolling array of 10 values with most 
recent Validate concentration in ppb in 
these registers 

30301-30302 Validate 2 ppb Concentration for Validate ppb 2 

30303-30304 Validate 3 ppb Concentration for Validate ppb 3 

30305-30306 Validate 4 ppb Concentration for Validate ppb 4 

30307-30308 Validate 5 ppb Concentration for Validate ppb 5 

30309-30310 Validate 6 ppb Concentration for Validate ppb 6 

30311-30312 Validate 7 ppb Concentration for Validate ppb 7 

30313-30314 Validate 8 ppb Concentration for Validate ppb 8 

30315-30316 Validate 9 ppb Concentration for Validate ppb 9 

30317-30318 Validate 10 ppb Concentration for Validate ppb 10 

30319-30320 Validate 1 ppb Average Average Concentration in ppb of preset 
numbers of cycles for Validate 

30321-30322 Validate 1 Area Scrolling array of 10 values with most 
recent Validate Area in these registers 

30323-30324 Validate 2 Area Validate Calibration Area 2 

30325-30326 Validate 3 Area Validate Calibration Area 3 

30327-30328 Validate 4 Area Validate Calibration Area 4 

30329-30330 Validate 5 Area Validate Calibration Area 5 

30331-30332 Validate 6 Area Validate Calibration Area 6 

30333-30334 Validate 7 Area Validate Calibration Area 7 

30335-30336 Validate 8 Area Validate Calibration Area 8 

30337-30338 Validate 9 Area Validate Calibration Area 9 

30339-30340 Validate 10 Area Validate Calibration Area 10 

30341-30342 Validate Area Average Avg Area of run cycles for Validate 
calibration 
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Discrete Input Register 
Range: 40001-40128 

R# Mnemonic Description (16-bit RW registers) 

40001 Output Average Number of process outputs to be averaged 

40002 Inject Valve Start  time in seconds from start of cycle to inject 
valve start 

40003 Inject Valve Stop time in seconds from start of cycle to inject 
valve stop 

40004 SSO Valve Start  time in seconds from start to SSO valve 
start 

40005 SSO Valve Stop time in seconds from start to SSO valve stop 

40006 Base Line Start  Cycle Time to start baseline acquisition 

40007 Base Line Stop  Cycle Time to stop baseline acquisition 

40008 Auto Zero Time AutoZero secs in cycle time 

40009 Peak Start Time Cycle Time to start peak acquisition 

40010 Peak Stop Time Cycle Time to stop peak acquisition 

40011 Run Mode Cycle Sec Time in seconds for 1 cycle 

40012 Instrument Status Bit level definition for internal use only 

40013 TOD_Sync_H Time of Day Sync Higher (upper 16-bits) 

40014 TOD_Sync_L Time of Day Sync Lower (lower 16-bits) 

40015 State Flag Bit level define last settings saved in flash 

40016 Purge Seconds Purge Time in seconds when mode switch 
occurs 

40017 Span Conc Warn Span concentration warning setting 

40018 Span Conc Alarm Span concentration alarm setting 

40019 Zero Conc Alarm Zero concentration alarm setting 

40020 FS_DAC1 Full Scale DAC1 in millivolts 

40021 FS_DAC2 Full Scale DAC2 in millivolts 

40022 Zero_DAC1 DAC1 zero value 

40023 Zero_DAC2 DAC2 zero value 

40024 Auto Cal Freq Days Auto Calibration frequency in days 

40025 Reserved  

40026 Alarm Mask Bit mask to enable alarm monitor 

40027 Cal Cycles Number of calibration cycles 

40028 Averages Smoothing filter setting (number between 1 
and 8) 

40029 DAC1_PV DAC1 process variable choice  

40030 Cycle End Cycle stop: 0=stop, 1=repeat, 2=hold 

40031 PMT_Volts PMT Volts (value between 0 and 999) 

40032 Reserved reserved 

40033 Number Of Cycles Number of Cycles to run  

40034 Reserved reserved 

40035 DAC2_PV DAC2 process variable choice  

40036 Cal Units %, ppm, or ppb 

40037 Override Minutes Cabinet purge override time in minutes 
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40038 Secs Until Repeat Cycle hold time minimum before a new 
start event 

40039 TOD_Cal Time of Day for calibrate (hh * 60 + min) 

40040 Warn Mask Bit mask for warning definition 

40041 Stream 1 Runs Total cycles of Stream 1 to run before 
switching 

40042 Stream 2 Runs Total cycles of Stream 2 to run before 
switching 

40043 Stream 1 Density Not applicable 

40044 Stream 2 Density Not applicable 

40045 Calibration Density Not applicable 

40046- 
40080 

Reserved Reserved 

 

R# Mnemonic Description (32-bit RW registers) 

40081-40082 Zero Cal Average Area Zero cal avg area response value 

40083-40084 Span Cal Average Area Span cal avg area response value 

40085-40086 Counts Per ppm computed detector counts per ppm = Response 
Factor 

40087-40088 Zero Saved Last saved zero value 

40089-40090 Span_DAC1 Span for DAC1 

40091-40092 Span_DAC2 Span for DAC2 

40093-40094 BLOffset_uV User input baseline offset value in uV 

40095-40096 Span Cal ppb Span cal conc ppb value 

40097-40098 Zero Cal ppb Zero cal conc ppb value 

40099-40100 Last Validate ppm Last value of Validate calibration conc in ppm 

40101-40102 Span Saved Last saved value of Span calibration 

40103-40104 Lamp Off Reference Lamp off reference saved in EEPROM 

40105-40106 MFC1 Low MFC1 Low range setting 

40107-40108 MFC1 High MFC1 High range setting 

40109-40110 MFC2 Low MFC2 Low Range setting 

40111-40112 MFC2 High MFC2 High Range setting 

40113-40114 TC1 Low TC1 Low Range setting 

40115-40116 TC1 High TC1 High Range setting 

40117-40118 TC2 Low TC2 Low Range setting 

40119-40120 TC2 High TC2 High Range setting 

40121-40122 MFC 1 Set point MFC 1 Setpoint setting 

40123-40124 MFC2 Set point MFC 2 Setpoint setting 

40125-40126 TC1 Set point TC 1 Setpoint setting 

40127-40128 TC2 Set point TC 2 Setpoint setting 

40129-40130 TC3 Set point TC 3 Setpoint setting 

40131-40132 TC3 Low TC 3 Low Range Setting 

40133-40134 TC3 High TC 3 High Range Setting 

40135-40136 Zero Low Alarm Zero Low alarm setting 

40137-40138 Zero High Alarm Zero High alarm setting 

40139-40140 Span Low Alarm Span Low alarm setting 
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40141-40142 Span High Alarm Span High alarm setting 

40143-40144 Stream 1 Low Alarm Stream 1 Low alarm setting 

40145-40146 Stream 1 High Alarm Stream 1 High alarm setting 

40147-40148 Save Process ppm Most recent stream value saved before power 
interruption – modifying this value is not 
recommended 

40149-40150 Reserved  

40151-40152 PMT Sample Playback sample data to detector 

40153-40154 Time Sample Playback sample time to detector 

40155-40156 Date Last Validate Days since 1/1/1900 – 32768 

40157-40158 Time Last Validate Time in Sec since validation 

40159-40160 Lamp on reference Reference saved in EEPROM 

40161-40162 Stream 2 Low Alarm Stream 2 Low alarm setting 

40163-40164 Stream 2 High Alarm Stream 2 High alarm setting 

40165-40240 Reserved Reserved 
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Section 5 – Purge System 
 

Section 5.1 Overview 
 

To prevent the possibility of fire or explosion inside the enclosures of energized electrical 

equipment, a protective gas supply is used to dilute potentially flammable vapors to an 

acceptable level, creating a safe area for the devices within the enclosure. Positive pressure 

prevents the ingress of flammable vapors in the surrounding atmosphere from entering into the 

enclosure as long as positive pressure is maintained. After the enclosure is purged, power may 

be manually applied to the protected electrical equipment. 

 

The Purge Solutions CYCLOPS Z – Purge Indicator provides objective evidence of positive 

enclosure pressure with both a visible indicator and supplied standard, a dry- contact output for 

remote status monitoring. The enclosure purge vent is an integrated part of the CYCLOPS Z – 

Purge Indicator’s casing, which mounts directly to the enclosure being purged. No additional 

holes, sheet metal, or plumbing is required. 
  

Section 5.2 Features 
 

• The CYCLOPS Z – Purge Indicator mounts directly to purged enclosure. No additional sheet 

metal enclosures or plumbing is required. (Refer to Figures 1, 2, 3, & 4) 

• Enclosure purge vent is an integrated part of the CYCLOPS Z – Purge Indicator casing. No 

additional holes or plumbing is required in purged enclosure. (Refer to Figure 4) 

• Dry contact output for remote monitoring is supplied as standard. Contact open on alarm 

(Standard). Contact closed on alarm (Optional). Order optional contact closed on alarm 

by adding an “X” at end of Purge Solutions model number. (Refer to Figure 4) 

• Rugged, visual green LED indicator. Green LED on; enclosure purge pressure at or above 

required pressure. Green LED off, enclosure purge pressure below required pressure. 

• The CYCLOPS Z – Purge Indicator is certified to ATEX, CEC, IECEx, NEC, NFPA, UL and CE 

Marked for installation and use in Division 2 and Zone 2 hazardous areas. 

 

Section 5.3 Options & accessories available 
 

Purge Indicator Casing: Anodized aluminum (standard) 316 stainless steel (optional). 

 

Input Voltages Available: Either 12 VDC, 24 VDC, 115 VAC, or 230 VAC. 

 

Purge Solutions Available Models: 
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• Type Z – Purge Indicator: 12 VDC, Anodized aluminum, Gas hazardous area installations: 

Purge Solutions model number PSCZ-1A 

• Type Z – Purge Indicator: 12 VDC, 316 stainless steel, Gas hazardous area installations: 

Purge Solutions model number PSCZ-1S 

• Type Z – Purge Indicator: 24 VDC, Anodized aluminum, Gas hazardous area installations: 

Purge Solutions model number PSCZ-2A 

• Type Z – Purge Indicator: 24 VDC, 316 stainless steel, Gas hazardous area installations: 

Purge Solutions model number PSCZ-2S 

• Type Z – Purge Indicator: 115 VAC, Anodized aluminum, Gas hazardous area installations: 

Purge Solutions model number PSCZ-3A 

• Type Z – Purge Indicator: 115 VAC, 316 stainless steel, Gas hazardous area installations: 

Purge Solutions model number PSCZ-3S 

• Type Z – Purge Indicator: 230 VAC, Anodized aluminum, Gas hazardous area installations: 

Purge Solutions model number PSCZ-4A 

• Type Z – Purge Indicator: 230 VAC, 316 stainless steel, Gas hazardous area installations: 

Purge Solutions model number PSCZ-4S 

• Type Z – Purge Indicator: 12 VDC, Anodized aluminum, Dust hazardous area installations: 

Purge Solutions model number PSCZ-1AD 

• Type Z – Purge Indicator: 12 VDC, 316 stainless steel, Dust hazardous area installations: 

Purge Solutions model number PSCZ-1SD 

• Type Z – Purge Indicator: 24 VDC, Anodized aluminum, Dust hazardous area installations: 

Purge Solutions model number PSCZ-2D 

• Type Z – Purge Indicator: 24 VDC, 316 stainless steel, Dust hazardous area installations: 

Purge Solutions model number PSCZ-2SD 

• Type Z – Purge Indicator: 115 VAC, Anodized aluminum, Dust hazardous area installations: 

Purge Solutions model number PSCZ-3AD 

• Type Z – Purge Indicator: 115 VAC, 316 stainless steel, Dust hazardous area installations: 

Purge Solutions model number PSCZ-3SD 

• Type Z – Purge Indicator: 230 VAC, Anodized aluminum, Dust hazardous area installations: 

Purge Solutions model number PSCZ-4AD 

• Type Z – Purge Indicator: 230 VAC, 316 stainless steel, Dust hazardous area installations: 

Purge Solutions model number PSCZ-4SD 

Vortex Cabinet Cooler Kit: For applications where thermal management of electrical cabinets 

and control panels are required; Purge Solutions offers Vortex Cabinet Cooler assemblies, which 

provide cooling capacities for your application and maintain a NEMA 4 and 4X (IP66) rating for 

installation and use in hazardous area. Contact your local Purge Solutions representative or the 

factory for sizing of system and installation information. 

 

Continuous Dilution Purge Gas Inlet Kit: For interfacing and regulating pressure of protective gas 

supply to enclosure. Small Continuous Dilution Purge Gas Inlet Kit for enclosures with a volume 
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up to 15 cubic feet (425 liters). Model number PSO-SCD-A is our small aluminum version and PSO- 

SCD-S is our small stainless version. Small Continuous Dilution Purge Gas Inlet Kit supply gas inlet 

to regulator is 1/4-18 FNPT. Medium Continuous Dilution Purge Gas Inlet Kit for enclosures with 

a volume up to 75 cubic feet (2,125 liters). Model number PSO-MCD-A is our medium aluminum 

version and PSO-MCD-S is our medium stainless version. Medium Continuous Dilution Purge Gas 

Inlet Kit supply gas inlet to regulator is 3/8-18 FNPT. Large Continuous Dilution Purge Gas Inlet 

Kit for enclosures with volumes up to 200 cubic feet (5,663 liters). Model number PSO-LCD-A is 

our large aluminum version and PSO-LCD-S is our large stainless version. Large Continuous 

Dilution Purge Gas Inlet Kit supply gas inlet to regulator is 1/2-14 FNPT. All kits include input 

fitting, regulator, gauge, bracket and mounting hardware. 

 

Manual Leakage Compensation Purge Gas Inlet Kit: Having two outlets from manifold able to 

increase the amount of purge gas to enclosure during dilution may be manually selected to speed 

up dilution of potentially flammable materials to an acceptable level, reducing dilution time and 

permitting a more rapid restoration of power to purge protected equipment. Small Manual 

Leakage Compensation Purge Gas Inlet Kits are for enclosures with a volume up to 15 cubic feet 

(425 liters). Model number PSO-SLC-A is our small aluminum version and model number PSO-

SLC-S is our small stainless steel version. Small Manual Leakage Compensation Purge Gas Inlet Kit 

supply gas inlet to regulator is 1/4-18 FNPT. Medium Manual Leakage Compensation Purge Gas 

Inlet Kits are for enclosures with a volume up to 75 cubic feet (2,125 liters). Model number PSO-

MLC-A is our medium aluminum version and model number PSO-MLC-S is our medium stainless 

steel version. Medium Manual Leakage Compensation Purge Gas Inlet Kit supply gas inlet to 

regulator is 3/8-18 FNPT. Large Manual Leakage Compensation Purge Gas Inlet Kit is for 

enclosures with volumes up to 200 cubic feet (5,663 liters). Model number PSO-LLC-A is our large 

aluminum version and PSO- LLC-S is our large stainless steel version. Large Manual Leakage 

Compensation Purge Gas Inlet Kit supply gas inlet to regulator is 1/2-14 FNPT. All kits include 

input fittings, regulator, gauge and manifold block. 

 

Back-Up Purge Gas Kit: In the even that the initial protective gas supply is lost, a back-up source 

of protective gas may be automatically applied to the protected enclosure. Purge Solutions model 

number is PSO-BUPG-K 

 

Back-Up Vent Kit: To protect the enclosure from over pressure; Purge Solutions offers two sizes 

of back-up vents. The first size is our Small Back–Up Vent for enclosures with a volume up to 15 

cubic feet (425 liters). Model number PSO-SBUV-S is our small side mount version and model 

number PSO-SBUV-T is our small top mount version. The second size we offer is our Medium 

Back-Up Vent for enclosures with volumes up to 75 cubic feet (2.125 liters). Model number PSO- 

MBUV-S is our medium side mount version and model number PSO-MBUV-T is our medium top 

mount version. The third size we offer is our Large Back-Up Vent for enclosures with volumes up 

to 200 cubic feet (5,663 liters). Model number PSO-LBUV-S is our large side mount version and 
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model number PSO-LBUV-T is our large top mount version. All Back-Up Vents are constructed of 

316 stainless steel and come with all mounting hardware. 

 

Protective Gas Loss Indicator Kit: An explosion-proof differential pressure switch may be 

installed to provide an alarm contact output signal to indicate the loss of the backup source of 

protective gas. Another explosion-proof differential pressure switch may be installed on the main 

protective gas supply to indicate that the primary protective gas pressure is adequate. Purge 

Solutions model number is PSO-PGLI-K. 

 

Differential Pressure Gauge Kit: Purge Solutions also offers an all stainless steel differential 

pressure gauge kit, which can be mounted on left side model number PSO-DPG-L, right side 

model number PSO-DPG-R, top model number PSO-DPG-T or bottom model number PSO-DPG-B 

of enclosure. 

 

GENERAL SPECIFICATIONS: 

 

Casing Dimensions: 

4.5” diameter x 1.9” tall (114.3mm diameter x 48.3mm tall). 

 

Operating Temperature Range: 

- 40ºF to 150ºF (- 40ºC to 65ºC). 

 

Purge Pressure Lower Limit: 

0.20 inches H20 (0.50 mbar). 

 

Casing: 

Anodized aluminum, 2.48 lbs. (1.13 kg), IP66, NEMA 4, (standard). 316 stainless steel, 6.70 lbs. 

(3.04 kg), IP66, NEMA 4X, (optional). 

 

Power Input / Consumption: 

0.5 Watts max. 

 

 

Voltage: 

12 VDC model (11 VDC to 16 VDC), 47 to 63 Hz. 

24 VDC model (19 VDC to 28 VDC), 47 to 63 Hz. 

115 VAC model (85 VAC to 160 VAC), 47 to 63 Hz. 

230 VAC model (130 VAC to 265 VAC), 47 to 63 Hz. 

 

Dry Contact Rating: 
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Contact open on alarm (Standard). Contact closed on alarm (Optional). 265 Volts AC / DC, 150mA 

max. 

 

Standard Hardware: 

All stainless steel mounting fasteners, o-ring, 1/4" (6.4mm) diameter vent restrictor, 

warning label, and CD with all required documentation. 

 

Hazardous Area Approvals: 

ATEX and IECEx 

II 3 G Ex nA nL [pz] IIC T6 “for Zone 2 gas hazardous areas” 

II 3 D Ex tD A22 IP66 T79°C “for Zone 2 dust hazardous areas” 

 

ANSI / ISA 12.4, NEC / NFPA 496, CEC and UL 

Class I, Division 2, Group A,B,C&D, T6 “for gas hazardous areas” Class II, Division 2, Group E,F&G, 

T6 “for dust hazardous areas” 

 

Certified to an Ambient Temperature Range of - 40ºF (- 40ºC) <Tamb< + 149ºF (+ 65ºC) CE Marked  
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Section 6 – Parker Valve System 

 

MAKE CERTAIN THE SYSTEM IN WHICH THE VALVE IS INSTALLED IS DRAINED AND/OR 

EXHAUSTED OF ALL PRESSURES BEFORE VALVE DISASSEMBLY OR REMOVAL OCCURS. 

1. Remove the two Vent Plate Bolts using a 1/4 inch wrench. 

NOTE: The heads of these bolts are protruding from the Vent Plate. 

2. Set these bolts and the Vent Plate aside for later use. 

3. Remove two Base Bolts using a 1/4 inch wrench. 

NOTE: The heads of these bolts are protruding from the Base. 

4. Set these bolts, the “Module Assembly” and two 2-008 O-Rings (face seals) aside for later 

use. 

5. Continue removing Base Bolts, Module Assemblies and O-Rings until all have been 

removed. 

6. Place all components in a clean, dry place until later use. 

 

Section 6.1 Module Disassembly (refer to Figure 1) 

 

NOTE: Module disassembly can be accomplished without removal from the system; however, insure 

 all pressures are drained or exhausted before disassembly occurs. 

Remove the four Long Bolts from the top of the Module using a 7/64 inch allen wrench. 

1. Remove the four Short Bolts from the top of the Module using a 7/64 inch allen wrench. 

NOTE: The upper portion (Valve Body and all components assembled within) can now be removed 

from the Base. 

2. Remove the Cap and Spring from the top of the Module and set aside for later use. 
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3. Insert one of the short bolts into a long bolt hole. Using a flathead screwdriver, pull up against the 

bottom of the piston head. Use the bolt head as a pivot point. 

 

 

 

Figure 1: Gen II R-Max Stream Select System Exploded View 

Cartridge Disassembly (refer to Figure 2) 

Secure the hex keyed portion of the Piston using a 5/32 allen wrench, and unthread the Stem Sub by 

rotating it counter- clockwise using a 3/8 inch wrench. 

Once unthreaded, gently pull the Piston from the top portion of the cartridge and the Stem Sub from the 

lower portion of the cartridge. 

  

NOTE: Both compone ts contact o-r ng seals. Insure care is taken not to damage the sealing 

surfaces. 

Removing the Stem Sub also releases the Center and Lower Bonnets. 

Remove the two 2-007 O-Rings and the PTFE Back-up Ring from the Center Bonnet. 

Remove the two 2-007 O-Rings and the PTFE Back-up Ring from the Upper Bonnet. 

Remove all O-Rings from their sealing grooves. 

NOTE: Careful not to mix them until reassembly has occurred. 

Set aside all components in a clean, dry place for later use. 
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Cartridge Reassembly (refer to Figure 2) 
Make certain all parts are free of dirt or other contamination before starting reassembly of this Cartridge. 

NOTE: Insure all O-Rings are lubricated with an appropriate lubricant. 

Install the 2-013 O-Ring onto the Lower Bonnet. 

Install the 2-017 O-Ring onto the Center Bonnet. 

Install the 2-018 O-Ring and 2-023 O-Ring onto the Upper Bonnet. 

Install the 2-020 O-Ring onto the Piston. 

Install into the small groove on the Center Bonnet and Upper Bonnet one 2-007 O-Ring, then the Backup 

Ring and then a second 2-007 O-Ring. 

 

While holding the top surface of the Lower Bonnet against the bottom surface of the Center 

Bonnet, and holding the top surface of the Center Bonnet against the bottom surface of the 

Upper Bonnet, carefully insert the Stem Sub through the O-Ring/Backup Ring assembly 

installed in steps 4 & 5. 

NOTE: Do not force the Stem Sub thr ugh the sealing area. Gently rotate the Stem Sub as it is 

pushed through the soft components. 

Install the Piston/O-ring assembly into the top bore of the Upper Bonnet. 

NOTE: Prior to assembly, insure the bore in which the Piston is installed is lubed with an 

appropriate lubricant. 

Using a 5/32 allen wrench on the Piston and a 3/8 inch wrench on the Stem Sub, thread the 

Piston Assembly to the 

Stem Sub. Torque to 12 in-lbs. 

NOTE: Exercise care not to damage the Stem Seat. 
 

Module Reassembly (refer to Figure 1) 
 

Make certain all parts are free of dirt or other contamination before starting reassembly of this 

Cartridge. 
 

Using an appropriate lubricant, apply a light film of lube onto all inner surfaces of the Valve Body. 

Install the Cartridges into the Valve Body until it is level with the top of the Valve Body. 

Install the 2-007 O-Ring, the 2-008 O-Rings and the 2-019 O-Ring into the appropriate grooves on 

the top of the Base. 

Install the Valve Body Assembly (from step #2) onto the Base. 

NOTE: An alignment pin has been pressed into the Base to insure proper assembly. 

Place the Springs onto the top of the Cartridge Assembly. 

Place the Cap onto the Spring such that the logo “Parker R-Max” can be correctly read when 

the base side marked “Actuation Air” is facing forward. 

Install the Long Bolts thru the outside holes in the Cap. 

Install the Short Bolts thru the inside holes in the Cap. 

Using a 7/64 inch allen wrench, torque all Bolts to 25 in-lbs. 
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Section 6.2 System Reassembly (refer to Figure 1) 

 

Install two 2-008 O-Rings into the grooves in the side of the End Plate. 

Align the Module Assembly with the End Plate and thread two Base Bolts thru the Base portion 

of the Module Assembly and into the End Plate until hand tight. Using a 1/4” wrench torque to 

60 in-lbs. 

NOTE: A portion of the End Plate protrudes below the Module Assembly. 

  

Install the remaining Module Assemblies by inserting the Base 

  

Bolts thru each remaining module and into the previously assembled Base Bolts until all Module 

Assemblies are installed. Torque all Base Bolts to 60 in-lbs. 

NOTE: During assembly, insure two 2-008 O-Rings are installed in the O-Ring grooves on each 

Module Assembly. 

 

Install the Vent Plate onto the end of the Assembled System and thread two Vent Plate Bolts thru 

and into the previously assembled Base Bolts. Using a 1/4” wrench, torque to 60 in-lbs. 

NOTE: The Vent Plate also protrudes below the Module Assembly. 

 

GC Module 
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Optional modules for venting sampled media to a low pressure header are disassembled and 

reassembled in the same manner as the standard module. 

 

One exception to this are the o-ring patterns in the Base (see figure 3). 

 

When assembling the system, the GC module is always assembled onto the End Plate. Any other 

manner of assembly will result in improper function of the R-Max System. 

 

 

Single Valve 

The Single R-Max is disassembled and reassembled in a similar manner as the standard module. 

The notable difference is four long screws are used to hold the valve body to the base. 
 

Also, when assembling the valve body to the base insure the marking on the valve body is 

directed to the base side marked “actuation air”. 
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NOTE: This filter is not meant for individual use. It can only be used in conjunction with the 

R-Max Stream Switching System. 

Filter/R-Max Disassembly 

1. Remove the two Screws (and Bracket if necessary) from the Body. 
2. Gently pull the Filter from the R-Max Module. 
3. If necessary, remove the Adapter from the R-Max Module using a 7/16 inch wrench. 
4. Remove the 2-008 O-Ring from the Adapter. 
5. Set all components aside for later use. 

 

Filter/R-Max Reassembly 

1. Install the 2-008 O-Ring onto the Adapter. Lubricate the o-ring to insure proper function. 
2. Thread the Filter Fitting into the R-Max. Insure a proper pipe thread sealant is used on the threads. 
3. Slide the Filter over the Adapter. Insure the Filter sits flush against the R-Max base. If not, remove 

the Filter, tighten the Adapter and repeat. 
4. Insert the Screws (over the Bracket if necessary) thru the Filter and thread into the R-Max. Torque to 

25 in-lbs. 
 

Filter Disassembly (w/particulate element) 
1. Using a 1” hex wrench remove the Bowl from the Body. 
2. Remove the Particulate Filter Element. 
3. Remove the 2-025 O-Ring. 
4. Set all components aside for later use. 
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Filter Reassembly (w/particulate element) 

1. Insert the 2-025 O-Ring. Insure it is not twisted or crinkled once within the groove. Lubricate 
to insure proper function. 

2. Insert the Particulate Filter Element over the Support Core. 
3. Apply an appropriate lubricant to the exterior threads of the Bowl and thread into the Body. 

Torque to 25 in-lbs. 
 

Section 6.3 Valve connector make-up instructions 
 

MALE AND FEMALE PIPE PORTS 

Wrench flats are provided on the Valve Body. It is recommended a smooth- jawed wrench or 

vise be used to grip the Valve Body. 

1. On the male threaded part of the connection, apply a high quality pipe joint compound 
or PTFE tape made for this purpose. When PTFE tape is used, it is recommended two full 
turns of tape be applied. PTFE tape should not be overhanging or covering the first thread 

2. Engage the Valve and the other component part together, until hand-tight. 
3. With a proper wrench, holding both the Valve and the component part, continue to tighten 

to achieve a leak-tight joint. 
 

TUBE FITTING CONNECTIONS 

Insert the tube into the Valve port until the tube bottoms out in the Valve Body. Care should be exercised 

to insure the tube is properly aligned with the Valve Body and port. 

1. Normal make-up for US Customary port sizes 1 thru 3 (1/16 thru 3/16 inch) and SI port sizes 2 thru 
4 (2 thru 4 mm) is 3/4 turn from finger tight. Normal make-up for US Customary port sizes 4 thru 
16 (1/4 thru 1 inch) and SI port sizes 5 thru 25 (5 thru 25 mm) is 1 1/4 turn from finger tight. For 
larger port sizes consult Parker Ferrule Presetting Tool Instructions. 

 

PLEASE FOLLOW THE ABOVE DIRECTIONS FOR COUNTING THE NUMBER OF TURNS FOR PROPER 

FITTING MAKE-UP. DO NOT MAKE-UP TUBE FITTINGS BY TORQUE OR "FEEL". VARIABLES SUCH 

AS TUBING AND FITTING TOLERANCES, TUBE WALL THICKNESS, AND THE LUBRICITY OF NUT 

LUBRICANTS CAN RESULT IN AN IMPROPERLY ASSEMBLED TUBE FITTING CONNECTION. 
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WARNING 

FAILURE OR IMPROPER SELECTION OR IMPROPER USE OF THE PRODUCTS AND/OR SYSTEMS 

DESCRIBED HEREIN OR RELATED ITEMS CAN CAUSE DEATH, PERSONAL INJURY AND 

PROPERTY DAMAGE. 

This document and other information from Parker Hannifin Corporation, its subsidiaries and 

authorized distributors provide product and/or system options for further investigation by users 

having technical expertise. It is important that you analyze all aspects of your applications and 

review the information concerning the product or system in the current product catalog. Due to 

the variety of operating conditions and applications for these products or systems, the user, 

through its own analysis and testing, is solely responsible for making the final selection of the 

products and systems and assuring that all performance, safety and warning requirements of 

the application are met. 

The products described herein, including without limitation, product features, specifications, 

designs, availability and pricing, are subject to change by Parker Hannifin Corporation and its 

subsidiaries at any time without notice. 

ALL PARKER VALVES MUST PASS A RIGID OPERATIONAL AND LEAKAGE TEST BEFORE LEAVING 

THE FACTORY. IT IS RECOMMENDED AFTER ANY REASSEMBLY, THE VALVE SHOULD BE TESTED 

BY THE USER FOR OPERATION AND LEAKAGE. IF THESE INSTRUCTIONS ARE NOT FULLY 

COMPLIED WITH, THE REPAIRED PRODUCT MAY FAIL AND CAUSE DAMAGE TO PROPERTY 

OR INJURY TO PERSONS. PARKER HANNIFIN CANNOT ASSUME RESPONSIBILITY FOR 

PERFORMANCE OF A CUSTOMER SERVICED VALVE. 

Parker Hannifin Corporation Instrumentation Products Division 
2651 Alabama Highway 21 North 

Jacksonville, Alabama 36265-9681 

Phone (256) 435-2130 
Fax (256) 435-7718 

 
Copyright 2013 Parker Hannifin Corporation All Rights Reserved 
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Section 7 – Postscript 
 

Section 7.1 ATOM Event Log 
 

The ATOM Event Log creates and maintains a text file in the “C:\ATOM!” folder, where the 

alarms and critical events are logged in a chronological order. The folder and file are both 

named “AtomLog”. The file can be viewed with Notepad or any program that can view/edit a 

text file. The log file or the AtomLog folder can be copied, moved or deleted at any time by 

the user. The Atom program will create a replacement folder and/or the file without losing 

data in the process. Each log entry has a date and time stamp, followed by a line of text 

describing the event. An “x” enclosed in brackets indicates a corresponding check box in the 

GUI that was checked/selected. Empty brackets indicate that the check box was un-

checked/deselected. The logic state of a Digital Input is indicated in parenthesis where (*) 

indicates the alarm state of a Digital Input. The level of alarm is indicated by the names in 

parenthesis: (RED) Alarm, (YEL) Warn or (GRN) Normal. 

 

16/07/13 09:03:02 --------------------------------------------- 
16/07/13 09:03:02 ATOM SGA/SLA-1000 Event Log Settings SnapShot 
16/07/13 09:03:02 where: (*) State = On , ( ) State = Off 
16/07/13 09:03:02 where: (GRN) = NORMAL, (YEL) = Warning, (RED) = Alarm 
16/07/13 09:03:02 ON OFF where: [x]=CheckedBox; [ ]= not CheckedBox 
16/07/13 09:03:02 [x] Stream1 Select On 
16/07/13 09:03:02 [x] Stream2 Select On 
16/07/13 09:03:02 [x] DI-1 Alarm Check On 
16/07/13 09:03:02 [ ] DI-1 Warn Check Off 
16/07/13 09:03:02 [x] DI-2 Alarm Check On 
16/07/13 09:03:02 [ ] DI-2 Warn Check Off 
16/07/13 09:03:02 [x] DI-3 Alarm Check On 
16/07/13 09:03:02 [ ] DI-3 Warn Check Off 
16/07/13 09:03:02 [x] DI-4 Alarm Check On 
16/07/13 09:03:02 [ ] DI-4 Warn Check Off 
16/07/13 09:03:02 [ ] DI-5 Alarm Check Off 
16/07/13 09:03:02 [ ] DI-5 Warn Check Off 
16/07/13 09:03:02 [ ] DI-6 Alarm Check Off 
16/07/13 09:03:02 [ ] DI-6 Warn Check Off 
16/07/13 09:03:02 [ ] DI-7 Alarm Check Off 
16/07/13 09:03:02 [ ] DI-7 Warn Check Off 
16/07/13 09:03:02 [ ] Zero Alarm Check Off 
16/07/13 09:03:02 [ ] Span Alarm Check Off 
16/07/13 09:03:02 [ ] Zero Warn Check Off 



20170418 ATOM SGA Manual  TraceS-1000 User’s Manual 

TraceS-1000 User’s Manual   Page | 122 

16/07/13 09:03:02 [ ] Span Warn Check Off 
16/07/13 09:03:02 [ ] Stream 1 Alarm State Off 
16/07/13 09:03:02 [x] Stream 1 Warn State On 
16/07/13 09:03:02 [ ] Stream 2 Alarm State Off 
16/07/13 09:03:02 [x] Stream 2 Warn State On 
16/07/13 09:03:02 (GRN) Zero Value L=0 V=3 H=4 
16/07/13 09:03:02 (GRN) Span Value L=0 V=1983 H=2025 
16/07/13 09:03:02 (YEL) Stream 1 Value L=1995 V=1984 H=2004 
16/07/13 09:03:02 (YEL) Stream 2 Value L=1069 V=1077 H=1074 
16/07/13 09:03:02 --------------------------------------------- 
 
 
Upon log creation, a header of the current state is printed between two dashed lines. There 
are two blank lines to separate the block from normal event data for a visual indicator when 
reviewing the data.. 
 
16/07/13 09:04:59 (YEL) Stream 2 Value L=1069 V=1061 H=1074 
16/07/13 09:06:20 (YEL) Stream 2 Value L=1069 V=1061 H=1074 
16/07/13 09:10:24 (YEL) Stream 1 Value L=1995 V=1983 H=2004 
16/07/13 09:11:45 (YEL) Stream 1 Value L=1995 V=1985 H=2004 
16/07/13 09:13:06 (YEL) Stream 1 Value L=1995 V=1991 H=2004 
16/07/13 09:17:10 (YEL) Stream 2 Value L=1069 V=1059 H=1074 
16/07/13 09:18:32 (YEL) Stream 2 Value L=1069 V=1062 H=1074 
16/07/13 09:19:52 (GRN) Stream 2 Value  
16/07/13 09:23:55 (GRN) Stream 1 Value  
 
A (YEL) Stream 1 Value L=1995 V=1984 H=2004 indicates that the stream 1 value is in Warnings 
with low reading where L=lower limit, H=higher limit and V=reading. All values are expressed in 
ppm.  
 
Other events include Check Calibration events as they occur. 
16/07/13 09:58:22 Auto Check Time Set: 00:10:00 (DD:HH:MM) 
16/07/13 09:59:09 (GRN) Stream 2 Value  
16/07/13 10:00:00 Auto Check Event Initiated 
16/07/13 10:00:40 Begin Zero Check cycle 
16/07/13 10:03:30 End Zero Check Cycle 
16/07/13 10:03:30 Begin Span Check cycle  
16/07/13 10:06:19 End Span Check Cycle 
16/07/13 10:06:19 Begin Validate Check cycle  
16/07/13 10:09:09 End Validate Check Cycle 
16/07/13 10:15:25 Calculate RF 
16/07/13 10:15:28 Save Calibration 
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In the above example, the user has clicked on Calculate RF and Save Calibration buttons. 
 
Setting Alarm Limits examples: 
 
16/07/13 10:37:41 Stream 1 High set = 2050 
16/07/13 10:37:41 (GRN) Stream 1 Value  
16/07/13 10:37:55 Stream 2 High set = 1200 
16/07/13 10:37:55 (GRN) Stream 2 Value  
16/07/13 10:38:08 Stream 2 Low set = 1000 
 
Setting Digital Inputs examples:  
16/07/13 10:38:47 (*) DI-5 Alarm on (GRN)  
16/07/13 10:38:48 (*) DI-6 Alarm on (GRN)  
16/07/13 10:38:49 (*) DI-7 Alarm on (GRN)  
 
External State Changes of DI-7 example: 
16/07/13 10:39:43 DI-7 (RED) Alarm  
16/07/13 10:40:53 DI-7 (OFF)  
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Section 7.2 ATOM Excel Trend Log 
 

The SGA program will create and maintain a comma delimited Trend Log text file suitable for 

importing into EXCEL by the user. 

1. The TrendLog.TXT is located in the “C:\ATOM!\AtomLog\” directory 

2. The easiest way to import the TrendLog.TXT into Microsoft EXCEL, is to rename the file 

as TrendLog.CSV. Then double-clicking this file will open it in EXCEL, importing the data 

to the spreadsheet. 

Following is an example of the ATOM Trend log file: 

Date/Time Stamp, Cycle, Stream1, Stream2, Cal Zero, Cal Span, Validate  
16/08/16 11:36:44 ,4433, 10015.4, 5323.4, 15.4, 9958.4, 5390.5 
16/08/16 11:38:05 ,4434, 9924.8, 5323.4, 15.4, 9958.4, 5390.5 
16/08/16 11:39:26 ,4435, 9896.3, 5323.4, 15.4, 9958.4, 5390.5 
16/08/16 11:40:47 ,4436, 9977.4, 5323.4, 15.4, 9958.4, 5390.5 
16/08/16 11:42:09 ,4437, 9977.4, 5287.9, 15.4, 9958.4, 5390.5 
16/08/16 11:43:30 ,4438, 9977.4, 5302.4, 15.4, 9958.4, 5390.5 
16/08/16 11:44:51 ,4439, 9977.4, 5277.6, 15.4, 9958.4, 5390.5 
16/08/16 11:46:13 ,4440, 9869.9, 5277.6, 15.4, 9958.4, 5390.5 
16/08/16 11:47:34 ,4441, 9924.8, 5277.6, 15.4, 9958.4, 5390.5 

 
As mentioned earlier, if the above file is saved as TrendLog.CSV, and opened in Microsoft Excel, 
it will appear as below: 
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Section 7.3 ATOM DCS Log 
 
The SGA program will create and maintain a comma delimited DCS communication text file 

suitable for importing into EXCEL by the user. 

1. The DCSLog.TXT maintains a running log of commands received by the ATOM from the 

DCS, i.e. the log records the status of Modbus Control Registers in the range R1  

through R64. 

2. The DCSLog.TXT is located in the “C:\ATOM!\AtomLog\” directory. 

 
Following is an example of the ATOM DCS Log file: 

" DCS: R2 Run = ON" 
" DCS: R2 Run = OFF" 
" DCS: R3 Calibrate Check Zero = ON" 
" DCS: R3 Calibrate Check Zero = OFF" 
" DCS: R4 Calibrate Check Span = ON" 
" DCS: R4 Calibrate Check Span = OFF" 
" DCS: R5 Calibrate Check Validate = ON" 
" DCS: R5 Calibrate Check Validate = OFF" 
" DCS: R6 Manual Zero Pulsed when Set = ON" 
" DCS: R7 Analyzer = ONLINE" 
" DCS: R7 Analyzer = OFFLINE" 
" DCS: R9 Calculate RF = ON" 
" DCS: R9 Calculate RF = OFF" 
" DCS: R10 Purge Override = ON" 
" DCS: R10 Purge Override = OFF" 
" DCS: R11 Base Line Set = ON" 
" DCS: R11 Base Line Set = OFF" 
" DCS: R12 BL Enable = ON" 
" DCS: R12 BL Enable = OFF" 
" DCS: R13 Lamp State = ON" 
" DCS: R13 Lamp State = OFF" 
" DCS: R14 PMT State = ON" 
" DCS: R14 PMT State = OFF" 
" DCS: R15 AutoCheck State = ON" 
" DCS: R15 AutoCheck State = OFF" 
" DCS: R17 Inject Valve = INJECT State" 
" DCS: R17 Inject Valve = VENT State" 
" DCS: R18 Sample Valve = Shut Off State" 
" DCS: R18 Sample Valve = Vent State " 
" DCS: R19 Stream 1 State DO = On" 
" DCS: R19 Stream 1 State DO = Off" 
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Section 7.4 Procedure To Auto-Tune Temperature Controller 
 

Whenever the thermocouple is replaced, the Temperature Controller needs to be “Auto-Tuned” for 
optimal performance. This is an automatic procedure which sets the PID control parameters that the 
Temperature Controller uses to maintain the “set” temperature value.  
 

Before beginning the Auto-Tuning procedure: 
 

• Install the new thermocouple (verify that the polarity is correct) 

• For proper Auto-Tuning, the furnace temperature must be cooled to less than 90% of the set 
point value (for a Set Point of 1050°C, less than 940 °C) 

• Verify that the Furnace breaker is switched ON 

• Verify that the Analyzer is in “Purge Override” (otherwise power to the furnace will remain 
disabled) 

 

Begin: 
 

  
  

  
 

  
 

Once the procedure is complete, the “AT” indicator will automatically turn OFF, and the optimized PID 
values should maintain the furnace at its set temperature. 
 

**Note :  During the Auto-tuning procedure it is normal for the furnace temperature to briefly 
 over-shoot the set temperature value.  

Press the key while holding down the  key and the 
Temperature Controller reads “AT” and the first line and “----” on the 
second line.  
 

Press the  key and both the top and bottom line on the 
Temperature Controller will read “AT”.  
 

Press the key to start the “Auto-Tune” procedure. The  
“AT” indicator will begin to flash ON and OFF, and the furnace 
temperature will begin to increase indicating that the Auto-Tune 
procedure is in progress.  
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Section 7.5 Calibration/Validation Procedure 
 

The Calibrate settings screen (Figure 1.1) is where all information regarding instrument 
calibration and associated calibration results are displayed.  
 

To access this screen press Settings > Calibrate Settings 

 
Figure 1.1 – Calibrate Settings Screen 

 

Manual Calibration:  
 
Settings  
 
1. Cycles/set ①: Set this to 5.  

2. Purge (Sec) ②: Set this to 60.  

3. Check Zero ③: Set this to 0 (zero).  

4. Zero Conc ④: Set this to 0 (Zero).  

5. Span Conc ⑤: Set this to SO2 concentration in the span/cal standard.  

6. Cal Units ⑥: Select unit based on the format of the value entered in Span Conc.  
 
Procedure  
 
1. Select Run Span ⑦. After 5 cycles of Span is completed, value in Check Span ⑧ will get 

 updated.  
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2. Select Calculate RF ⑨. Wait for the value to get updated in RF=Count/ppm ⑩.  

3. Select Save Calibration ⑪ after the indicator on this button turns green.  
4. Values in Saved Zero ⑫ and Saved Span ⑬ will get updated and will be same as ③ & ⑧.  
 
 

Manual Validation:  
 
Settings  
 
1. Keep all the settings same as in Manual calibration.  
 
Procedure  
 
1. Select Run Span ⑦.  

2. Select View Results ⑭. Screen Check Calibration Results will open (Figure 1.2).  
 

 
Figure 1.2 – Check Calibration Results Screen 

 
3. After 5 cycles are completed the value at ⑮ should be value of SO2 concentration in  
 span/cal standard.  
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Field Certification 

Certificate of Compliance 
Certificate: 2744021  

 

Project: 2744021 Date Issued: 2014-08-29 
 

Issued to: ATOM Instrument, LLC. 

1656 Townhurst Dr. 

Houston, TX. 77043 

USA 

Attention: Franek Oltowski 
 

The products listed below are eligible to bear CSA Field Certification Labels, 

bearing the CSA Mark shown with adjacent indicators 'C' and 'US'. 
 

 

 

 

Issued by: Tony DeSousa CET 

 

 

 

 

 
 

PRODUCTS 

CLASS – 2258 02 – PROCESS CONTROL EQUIPMENT - For Hazardous Locations 

CLASS – 2258 82 – PROCESS CONTROL EQUIPMENT - For Hazardous Locations - US requirements. 

 

Class I Division 2 Groups B, C and D. T3, Purge type “Z”. 

 

Model ATOM TraceS-1000 rated; 120 Vac@25.0 Amps, 60 Hz. 
 

CSA Field Certification Label(s) issued: FC 249403 to FC 249407. 

 

 

 

APPLICABLE REQUIREMENTS 
 

CSA Standard C22.2 No 0-10 - General Requirements - Canadian Electrical Code, Part II 

CSA Standard C22.2 No 0.4-04 - Bonding of Electrical Equipment 
CSA Standard C22.2 No 142-M1987 - Process Control Equipment 

DQD 507.07 Rev. 2010-04-22 
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Certificate: 2744021 
 

 

 

LTR 10E-2005 - Purged and Pressurized equipment for use in Class I Hazardous 

Locations – North American (Division System) Purging based on NFPA- 496 

UL 508 17
th 

Ed. - Electric Industrial Control Equipment. 

NFPA 496:2013 - Purged and Pressurized Electrical Equipment. 

 

 

MARKINGS 

Y Submittor’s name. Y 

Model designation. Y 

Electrical ratings. Y 

Serial number. 

Y Hazardous Location designation 

Y Temperature code 

Y Purge type 

Y The following statement: 
 

 

 “WARNING: EXPLOSION HAZARD - SUBSTITUTION OF COMPONENTS MAY IMPAIR 

SUITABILITY FOR CASS I, DIVISION. 2. Or equivalent 

 

 

Y WARNING; Enclosure shall not be opened unless the area is known to be Non-hazardous, or 

unless all devices within the enclosure have been de-energised. Power must not be 

restored after enclosure has been opened until enclosure has been purged for 10 Minutes at 30 PSIG Note; 

Read all labels before operating this purged system. 

 

Y “Type Z Purge System.” 

 

Y “WARNING; Hot internal components, wait 3 hours prior opening enclosure prior to work.” Or equivalent. 
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